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Surveyor/400 Introduction /

Surveyor/400 Introduction
Surveyor/400 is an award-winning solution that maximizes the value of the IBM i (AS/400).
With its intuitive interface and high performance features, Surveyor/400 truly improves how we
interact with the IBM i . Today, literally thousands of users enjoy the productivity gains of
Surveyor/400 on a daily basis.

Surveyor/400 provides features that can be used by both IT personnel and end-users. For
instance, IT personnel can utilize Surveyor/400 to quickly access and work with database files,
libraries, objects and IFS files on the IBM i . End-users can also utilize Surveyor/400 to easily
query, view and download IBM i data and spooled files.

With the extensive security controls built into Surveyor/400, an organization has the control
over which features are available for each individual user.
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Surveyor/400 Introduction /
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Getting Started /

Getting Started
The first time Surveyor/400 is launched, you will be prompted for information to connect to an
IBM i in your network.

Key in the values and press Enter to add the IBM i connection into Surveyor/400.

Field Descriptions:

Descriptive
name

Description of the IBM i system (i.e. Development, Test, Production) for
reference purposes only.

IP or Host name The IP or host name of the IBM i to connect to.

User ID IBM i user profile for signing onto the system. If a user profile is entered,
then it will be saved on your workstation. Leave blank if you want to be
prompted for the user id when a connection is requested.

Password Password for the IBM i user profile. If a password is entered, then it will
be saved on your workstation. Leave blank if you want to be prompted
for the password when a connection is requested.

IASP Name of the IASP to connect to. Optional.
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Getting Started / Additional IBM i Connections

SSL Check this option to make an SSL connection. First you must acquire a
digital certificate.

Show Additional
Factor

If the users use additional factor (MFA) authentication, check this option.
If users do not use MFA, it is recommended to not check this option .

After entering the connection information on the dialog, the IBM i entry will then be listed on
the left panel of the screen. Double-click this IBM i entry to connect to it.

NOTE:

If this is the first time that Surveyor/400 has accessed the IBM i , a dialog will prompt to
install the Surveyor/400 back-end objects onto that IBM i . Make sure that the FTP server is
running on your IBM i before installing the Surveyor/400 objects. Your user id must have
authority to the RSTLICPGM command. The Surveyor/400 objects will be installed as a
licensed program named 4SURVEY and stored in a library called SURVEYOR.

Additional IBM i Connections
More IBM i systems can be added to Surveyor/400 by selecting the Main menu and clicking
the Add System option. Each connection can be a specific IBM i machine on the network, a
LPAR on an IBM i or an IASP on an IBM i .

If changes need to be made to an existing IBM i connection, select the Main menu and click
the Configure option.
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Accessing Database Files /

Accessing Database Files
Surveyor/400 allows you to quickly access Database File Objects using the following
techniques.

l Access the object by its name using the Fast Path

l Drill down to the object through the Visual Tree

l Find the object using the Search tool

l Access the object through a user-defined File Group

NOTE:

If the Surveyor/400 administrator restricts your library list, then you will only be able to
work with files in your assigned list of libraries.
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/ Fast Path

Fast Path
The Surveyor/400 Fast Path allows you to quickly access an IBM i object by its name. If the
Fast Path dialog is not displayed, you can open it by clicking the lightning bolt icon on the main
toolbar.

Field Descriptions:

Object Name of the IBM i object to work with. Either enter a name or select a recently
accessed object name from the drop-down list.

Library Library where the object is located. Either enter a library name or choose a library
list type from the drop-down list.

Type Object type. Either enter the object type or choose from the drop-down list.

Member If the Object type is *FILE, you can enter a particular member to work with.

System IBM i system where the object is located. Choose from the drop-down list.

After entering the values on the Fast Path dialog, you can then click the function (button) you
wish to work with. See the next page for more information on the Fast Path functions.
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/ Fast Path

Fast Path Functions (buttons and usage notes)

Button Descriptions:

Properties Shows properties for the file (i.e. creation date, size, authority, etc.)s a list of
properties for the selected IBM i .

Export Exports (downloads) records from the file.

FTP Sends the file object to another IBM i or to the workstation.

Add To
Group

Adds the file into a file group for tracking.

Generate
SQL

Generates SQL script (DDL) for the file.

Generate
DDS

Generates the DDS source for the file.

Edit Opens the File Editor for the database file.

Run SQL Opens the SQL Editor for running SQL statements against the file.
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/ Fast Path

Custom
CMD

Prompts for running an OS/400 command against the selected file.

Custom
SBM CMD

Prompts for submitting an OS/400 command against the selected file.

Maintain Allows for altering or deleting the file definition.

Close Closes the Fast Path Window.

Usage Notes:

l Choosing the blank 'Object' resets all of the other fields

l When Fast Path is first opened or after the fields have been reset by selecting the blank

'Object', a library name may be typed in the 'Library' field and 'Library Properties' will be

displayed if the user clicks the 'Properties' button.

l If a user does not choose a 'Library', 'Object' or 'File' and clicks on the 'Properties' button

the 'System Properties' display.

l By default the 'Enter' key activates the 'Properties' feature. The 'Enter' key can be

configured to open different features. See Fast Path Preferences located on the

Configure screen.

l If wildcards are used in the 'Object' or 'Library' fields the Object Search feature will be

opened.

Visual Tree

The Surveyor/400 Visual Tree allows you to explore IBM i systems and work with libraries and
objects within those systems.
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/ Fast Path

You can locate an object in the Visual Tree by following the instruction below:

1. Double click the IBM i on the left panel to connect to it.

2. Double click the Database folder under the IBM i .

3. A list of libraries will be displayed. Each library is represented as an icon that appears

as a row of books . By default, the library list for your user profile’s job description

will be displayed. If you want to modify the list of libraries displayed in the Visual tree,

follow the Library List instructions.

4. Double click the desired library to open its folder.

5. Objects are categorized into folders by their object type.

l The “Physicals” folder contains physical files (tables). Each Physical file is

represented by an icon that appears as a purple book .

l The “Logicals” folder contains logical files (indexes). Each Logical file is

represented by an icon that appears as a green book .
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/ Fast Path

l The “Object Filters” folder contains non-database objects (i.e. data areas,

programs, etc.)

6. When you double click a folder, its contents will be listed on the right side of the screen.

You can use the mouse to resize or move columns in this list. By right-clicking any

column heading in this list, you can choose menu options to hide/show columns,

search a column, sort a column, print the list or export the list to the clipboard or a PC

format.

7. When you see an object you want to work with, right-click the object to display a list of

menu functions to perform.

TIP:

Using the Visual Tree, you can drill down into a physical file to view its fields, members,
formats and dependent logical files. This information can also be printed and exported.
For instance, to print a file field layout:  1) Double-click the file  2) Expand its fields folder 
3) Right-click a column heading above the fields 4) Choose the Print option.
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/ File Groups

File Groups
Database files which are worked with frequently can be organized into one or more File Groups
for quick access. Files from different libraries, IBM i systems can be placed into the same File
Group definition.

NOTE:

File Groups are similar to having ‘Favorites’ in Internet Explorer.

Adding files to a File Group

You can add files to a file group using one of the following techniques:

l From the Fast Path dialog, key in the file and library name and click the ‘Add to Group’

button. You will be prompted to either add a file to an existing File Group or to create a

new File Group.

l Right-click a physical or logical file in a list and select the option 'Add To Group'.

TIP:

From within the Visual Tree and File Search screens, you can select multiple files in the list
with the control or shift key. Then you can choose ‘Add To Group’ from the right-click
menu.

The file’s name, library, IBM i system will be stored in the File Group, along with the date/time
in which the file was added to the group and its current size. File Group definitions are stored
on the workstation.

Using File Groups

To open the list of File Groups, click the File Groups icon on the main toolbar. Double-click a

File Group to display the list of files within it.
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/ File Groups

You can scroll the file list to the right for viewing more information about the files. You can
also use the mouse to resize or move columns in the list of files displayed. By right-clicking
any column heading in this list, you can choose menu options to hide/show columns, search a
column, sort a column, print the list or export the list to the clipboard or a PC format.

TIP:

File Groups can be used to track file size changes over time by comparing the current
sizes to the sizes of the last reference. Click the Reset button if you want to reset the
reference sizes to the current sizes.

Right-Click Menu Options

When you find the file you want to work with, then right-click it to display a list of menu
functions to perform. For instance, click the “Edit” option to work with the records in the
database file.
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/ SQL Search

SQL Search
IBM i database objects (tables, physical files, source files, views, logical files, indexes,
procedures, functions, triggers, and constraints) can be found quickly using the comprehensive
SQL Search feature in Surveyor/400.

Search Types

l DB Files. All types of database files can be searched for. Such as tables views and

indexes. The results distinguish SQL types from DDS types. Using the 'Custom' feature

can determine which types are returned. For example you can search for Physicals and

Source files while excluding SQL tables. The 'Tables Advanced' option allows searching

by size and number of records.

l Indexes. SQL indexes can be searched for. Checking the 'Unique only' box returns

unique indexes. 'Indexes Advanced' allows date criteria.

l Procedures. Stored procedures can be searched for by Specific or Routine name. The

'Show more detail' option displays the 'SQL Path' and 'Routine Definition'.
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/ SQL Search

l Triggers. Triggers can be searched for by file name or trigger name.

l Constraints. Constraints can be searched for by file name or constraint name.

l Functions. SQL Functions can be searched for by Specific or Routine name. The 'Show

more detail' option displays the 'SQL Path' and 'Routine Definition'.

Date, Size, Owner, Description and Record criteria also may be specified
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/ File Search

File Search
IBM i database objects (physical files, logical files, tables, indexes) can be found quickly using
the comprehensive File Search feature in Surveyor/400. Click the binoculars icon on the main
toolbar to access the File Search screen.

Over a dozen different search criteria can be specified through the various tabs panels. Each
tab in the File Search screen is an additional filter which narrows your search:

Basic Tab

Specify a File, Library, Type and/or IBM i to search. File can be a specific name, *ALL or a
generic name (by keying a partial name with an asterisk * in front and/or behind it). The Library
can be a specific name or a library list.

TIP:

Specify *CUST* in the File to find any files which have the word CUST within the name.

Date Search

For finding files Created, Modified, Saved, Not Saved, Last Used and Not Used within a certain
time frame or are within a duration of days.
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/ File Search

TIP:

For system cleanup, the “Not Used” option is a quick way to find unused files.

Size Search

For finding files which meet a minimum size, maximum size or are within a size range.

User Search

For finding files created by a particular User id.

Records Search

Used for finding files which have a certain percentage of deleted records. Enter the minimum
percentage of deleted records to find in files. The resulting file list displayed will include the
number of deleted records and percentage of deleted records. Files which meet minimum, 
maximum, or are within a record range can be searched for.

Description Search

Used for finding files which have the specified text in the file description.

File Search

After specifying the search criteria, click the “Search” button to execute the search process.
The amount of time to perform the search depends on a number of variables, including the
scope of your search and your IBM i performance. For instance, results will be returned faster
when searching a specific library name, versus *ALL libraries.

TIP:

An actively running search can be cancelled by pressing the Escape button on your
keyboard.

Working with the File List

After the search finishes, a list of files meeting the filter criteria will be displayed.
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/ File Search

You can scroll the file list to the right for viewing more information about the files. You can
also use the mouse to resize or move columns in the list of files displayed.

By right-clicking any column heading in this list, you can choose menu options to hide/show
columns, search a column, sort a column, print the list or export the list to the clipboard a PC
format or another database file.

Right-Click Menu Options

When you see the file you want to work with, you can right-click it to display a list of menu
functions to perform. For instance, click the “Edit” option to work with the records in the
database file.
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Database File Editor and Query Tool /

Database File Editor and
Query Tool
Surveyor/400's File Editor allows users to query and work with records (rows) in a DB2/400
database file. Database records are presented through an intuitive spreadsheet-like interface.

With its highly-optimized paging technology, the Surveyor/400 File Editor allows you to work
with files that contain millions of records without impacting performance.

Using the File Editor, records can quickly be found by the file’s key fields or with search filters.
Records can be viewed, printed and downloaded into a variety of formats. With the proper
authority, the File Editor can be used to add, change, and delete database records.

Custom screen layouts can be created over files by moving, resizing and hiding columns using
the mouse. These layouts can be saved and shared with other users.
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/ Accessing the File Editor

Accessing the File Editor
The File Editor can be accessed from either the Fast Path dialog or by choosing the ‘Edit’ or
‘View’ option when right-clicking a file (i.e. from the Visual Tree, File Search or File Groups).
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/ Screen Explanation

Screen Explanation
The File Editor screen has five distinct sections. These sections are described below, starting
at the top of the screen.

l The Menu Bar is located at the top of the screen and provides access to File Editor

functions and preferences.

l The Toolbar is the row of icons located below the Menu Bar. You can move the mouse

on top of a toolbar icon to get a short description of its function. Click the icon to

perform the function.

l The current database file’s column headings are located below the Toolbar.

l The database file records are listed under the column headings in a spreadsheet-like

format. The relative record number (RRN) of each record is displayed in the left-most

column. The remaining columns contain the record values.

l The icons at the bottom of the screen allow you to page through the file and perform a

screen refresh.
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/ Paging

Paging
Database records are paged into the File Editor screen. This paging technique allows you to
work with files which may have millions of records without sacrificing performance.

NOTE:

Records are not locked when displayed on the File Editor screen.

When a file is opened in the File Editor, the first page of records will be displayed. The default
page size is 50 records. You can click the arrow buttons at the bottom of the screen to page
through the file.

Page forward

Page backwards

Position to End

Position to Beginning

NOTE:

If you want to change the default page size, you can select the ‘Edit’ drop-down menu and
select ‘Preferences”. Then specify the value for the page size.
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/ Positioning to a Record

Positioning to a Record
You can position to a record using the file’s key fields or by relative record number (RRN).

To position to record(s) in the file, either click the toolbar icon or press the F7 function key.
If the file has key fields, you will be prompted with the ‘Enter Key’ dialog. Type in a full or a
partial key and press Enter to position to the record(s) that best match the key.

TIP:

You can have multiple ‘Enter Key’ or ‘Enter RRN’ dialogs opened on the screen at the same
time, allowing you to jump back and forth between records… like bookmarks.

If the file is not keyed, you will be prompted with the ‘Enter RRN’ dialog. Type in the relative
record number and press enter to position to the record.

A keyed file can be positioned to by relative record number by first selecting ‘RRN Order’ under
the ‘Options’ menu.
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/ Selecting another Key (Logical File)

Selecting another Key (Logical File)
If the current file does not have the needed keys for positioning to the record(s), you can click
the toolbar icon to view the database relations for a file. A list of related logical files will be
displayed, which will show the logical file names, keys and select/omit criteria.

Double click the file you want to open. You will then be able to position to records using that
file’s key(s).
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/ Selecting Another Member

Selecting Another Member
Surveyor/400 supports multi-member files. When you open a file in the File Editor, the first
member in the file is selected.

If you want to open a different member in the file, first click the toolbar icon to view a list of
the members in the file. Double click the member you want to open.
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/ Selecting Another Format

Selecting Another Format
Surveyor/400 supports multi-format files. When you open a file in the File Editor, the first
format in the file is selected.

If you want to open a different format in the file, select the ‘Tools’ drop-down menu and then
choose the ‘Formats’ menu item. A list of formats in a file will be displayed. Double click the
format you want to open.
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/ Viewing Multiple or Single Records

Viewing Multiple or Single Records
By default, multiple records will be shown on the screen in a spreadsheet-like format.

If you just want to view just one record at a time, click the toolbar icon. The record selected
will be shown in vertical format.

To change back to view multiple records, click the  icon again.

TIP:

You can change the default to display one record at a time for future sessions by changing
the Preferences under the ‘Edit’ menu.
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/ Viewing Field Properties

Viewing Field Properties
There are two different approaches for viewing field properties (types, lengths, descriptions) in
the file.

To view properties for a single field

Position the mouse on top of the column heading of the field. After a couple seconds, a pop-up
will display the type, length and description of the field.

To view properties for all fields in the file

Click the toolbar icon to display a list of all fields in the file, along with their types, lengths
and descriptions.

Surveyor User Guide www.fortra.com page: 33



/ Filtering Records

Filtering Records
A custom filter can be defined to show records in the file that meet one or more conditions. To
display the filter screen, click the toolbar icon.

(Filter example to select records in the states of NE or IA, with an age to be prompted when the
filter runs)

Up to 99 levels of conditions can be specified on the ‘Query’ tab of the Filter screen. You can
enter each condition as a separate row on the screen. A condition (row) can be specified with
the following values:

Paren When specifying multiple conditions, parenthesis can be used to build
algebraic expressions. Select the parenthesis from the drop-down list.
Optional.

Field Field name in the file to perform the condition for. To select a field name, click
in the cell and then click the in the cell to display a list of fields to choose
from.

Operation Comparison operation, which can be selected from the drop-down list.

Type Type of value to compare the Field against. VALUE, FIELD, FUNCTION or
PROMPT.
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/ Filtering Records

Value l If Type is VALUE - Enter a constant value for the compare.

l If Type is FIELD - Select another field in the file for the compare.

l If Type is FUNCTION - Select a current date or time for the compare.

l If Type is PROMPT - Enter the default value. When the filter is executed,

the user will be prompted to specify a value.

Paren Right parenthesis. Optional.

And/Or When specifying multiple conditions, select either *AND or *OR for building the
algebraic expression.

A condition (row) can be moved on the screen by dragging the icon (located in the Drag
column) up or down with the mouse. The following toolbar options can be used to insert and
delete conditions (rows).

Clears the selected row.

Deletes the selected row.

Inserts a row before the selected row.

The buttons listed on the bottom of the filter screen are described below:

Reset - Removes the filter and then shows all records in the file.

Clear All - Clears all the conditions on the filter screen.

Show Count - Shows a count of the file’s records that meets the filter conditions.

Execute - Applies the filter and displays the records selected.

Close - Saves and Closes the filter screen. Any filter changes will not be applied.

Cancel - Closes the filter screen without saving any changes made to the filter.
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/ Running a Filter with Prompts

Running a Filter with Prompts
If a filter was defined with PROMPT type fields, then you will be prompted for their values when
the filter is executed. You can specify another set of values for the PROMPT fields (without
going back into the filter screen) by clicking the ‘Run Filter’ icon on the File Editor toolbar.
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/ Sorting Records

Sorting Records
By default, the File Editor will order the records on the screen by relative record number for
non-keyed files or by the key fields for keyed files.

You can change the sorting order by clicking the toolbar icon and then click the ‘Sorting’ tab.

(Example of a Custom Sort)

Click the appropriate radio button to define the type of sorting to perform:

RRN Sorts the records on the screen by relative record number.

Key
Order

Sorts the records on the screen by the file’s key fields.

Custom Allows you to specify custom sorting by one or more fields. To select a field name,
click in the cell below the ‘Field’ heading and then click the in the cell to display
a list of fields to choose from. Under the ‘Order’ heading, specify either *ASCEND
(for ascending order) or *DESCEND (for descending order).

Click the ‘Execute’ button to apply the Sorting criteria.
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/ Modifying Field Layouts

Modifying Field Layouts
Click the toolbar icon to display the ‘Modify Layout’ screen. A list of all the fields in the file
will be displayed.

Changing Column Headings

By default, the file’s field descriptions will be used as the column headings in the File Editor.

If you want to use the field names as the column headings, click the toolbar icon.

If you want to specify custom headings, click the toolbar icon to open the ‘Modify Layout’
screen. For each field, you can specify a custom column heading in the rightmost cell of this
display.

Other Modify Layout Features

By default, the file’s fields (columns) will be listed on the screen in the order in which they are
defined in the file. The columns are automatically sized based on the width of the column
headings and data.

Adjusting the size of a Field’s Column

Position the mouse on the right side of the column heading and drag it (holding down the
mouse button) left or right to resize it.
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/ Modifying Field Layouts

Moving Fields

When viewing multiple records in horizontal format, a field can be moved on the screen by
dragging the column heading left or right. When viewing a single record in vertical format or
from the Modify Layout screen, a field can be moved on the screen by dragging the column
heading up or down. Right-clicking a field in the Modify Layout screen provides options to
move a field quickly to the bottom or top.

To place the key fields at the top, click the ‘Keys First’ button at the bottom of the Modify
Layout screen.

Hiding a Single Field

To hide a single field, you can either uncheck the field in the Visible column in the Modify
Layout screen or right-click the column heading and choose the ‘Hide’ menu option.

Controlling Field visibility and usability using the ‘Modify Layout’ Screen

Hiding a field Uncheck the ‘Visible’ checkbox next to the field(s) to hide.

Hiding a field on
the Filter screen

Uncheck the ‘Visible In Filter’ checkbox.

Making a field not
editable

Check the ‘Protect checkbox.

Restrict Visible Checked fields will not be visible to users who have the 'Modify Visible
Fields' authority unchecked.

Restrict Filter Checked fields will not be visible on the Filter screen to users who have
the 'Modify Filter Fields' authority unchecked.

Restrict Protected Checked fields will not be allowed to be unprotected by users who have
the 'Modify Protected Fields' authority unchecked.
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/ Modifying Field Layouts

.

Click the ‘Reset’ button to return the fields to their original positions as defined in the file.

When done making your changes, click the ‘Accept’ button to apply the changes to the field
layout.

NOTE:

The underlying database structure is not altered when moving or hiding fields in the File
Editor.
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/ Printing Records

Printing Records
To print the current page of records, click the toolbar icon. You can optionally preview the
report by clicking the toolbar icon. An optional custom heading can be entered to place at
the top of the report.

From the preview window, lines can be drawn around the fields by clicking the ‘Grid Lines’
check box. If the fields run off the end of the report, click the ‘Compress Columns’ check box to
fit the fields onto the report.

TIP:

The report’s data will be in the same layout as shown on the File Editor screen. If you want
the fields on the report to be in a different arrangement or have different column headings,
then you need to make those field layout changes in the File Editor as described in the
prior pages.
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Exporting (Downloading) Records
To export records within the File Editor, click the down-arrow in the toolbar icon. A drop-
down menu will be displayed.

Options defined:

Export
File/Filter

If a filter is applied, then all of the records selected in the filter will be exported. If
a filter is not applied, then all of the records in the file will be exported.

Export
Page

Exports the current page records.

Export
Selected

Exports only the records selected. A record must first be selected by clicking its
relative record number in the left-most column. Multiple records can be selected
by holding down the shift or control key when clicking.

After choosing the export option, the Export Wizard will appear. You can then select the file
format to create and other export options. Individually selected records can also be exported
to the clipboard.

The exported records will have fields in the same layout as shown on the File Editor screen. If
you want the fields in the exported file to be in a different arrangement or have different
column headings, then you first need to make those field layout changes in the File Editor as
described in the prior pages.

TIP:

To export a single record, you can right-click the record’s relative record number in the left-
most column and choose ‘Export Selected’.
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Editing Records
The Surveyor/400 File Editor allows you to edit (add, change, delete) records in a database file.
To edit records in a database file, you must have the proper OS/400 authority to the object and
must also have been granted ‘Edit’ rights by the Surveyor/400 administrator.

Field definitions and database rules will be enforced when adding or changing records. For
example, you will not be able to key alpha data into a numeric field or key an invalid value into a
date field.

Any defined unique key constraints, triggers and RI constraints will also be enforced. For
instance, you will not be able to enter a duplicate customer number if this is a unique key.

TIP:

An audit trail can be created to log any database record additions, changes and deletions.
See page "Audit Logging" on page 48 or page "User Access - File Editor Audit tab" on
page 170 to learn how to turn on an audit trail.

Adding Records

To add a new record to a database file, click the button on the left side of the toolbar. A
screen will prompt for the record’s values.

TIP:

You can protect fields from entry or force fields to upper case through the ‘Modify Layout’
screen.

If needed, you can rearrange fields on the screen by dragging their field headings up or down
with the mouse.

Surveyor User Guide www.fortra.com page: 43



/ Editing Records

To start keying in the record values, click in a cell under the ‘Data’ heading. Key in the field
value and press the tab key to advance to the next field. You can then key in the next field’s
value. Repeat for the remaining fields.

After keying the values for the record, click the ‘Add’ button at the bottom of the screen to add
the record to the file. You will then be prompted to enter the next record.

When done adding records, you can either exit the File Editor or return to Display or Edit
mode.

Adding Multiple Records with Similar Values

When adding multiple records that will share some of the same values, you can reduce keying
time by having the File Editor carry selected field values forward from the previously added
record. To carry a field value forward, right-click the field heading and choose ‘Carry On Add’.

Alternatively, you can open the ‘Modify Layout’ screen by clicking the toolbar icon and set
the ‘Carry On Add’ flag for one or more fields.

Duplicating Records

To duplicate a record when in multiple-record mode, find the record you want to duplicate and
right-click its relative record number (RRN) to bring up a list of menu options.

l Choose the ‘Duplicate Selected’ option to duplicate the record in its entirety.

l Choose the ‘Duplicate Prompt’ option to copy the record’s values into the ‘Add’ screen.

You will then be able to change field values before adding the record to the database.

You can also duplicate a record in single-record mode by choosing one of the duplicate
options from the ‘Options’ drop-down menu.
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Changing Records

To change records in a database file, you need to first toggle to ‘Edit’ mode by clicking the
button on the left side of the toolbar. Find the record you want to change and then click in the
cell of the field you want to modify.

Key the new field value in the cell. You can then advance to the next field using the tab key. To
update the record in the database file, press the Enter key or move to another record.

Note: The File Editor does not hold locks on records which are displayed on the screen. Before
performing an update, a comparison is performed to make sure the database record wasn’t
changed by another user/application. If the comparison fails, then you will be required to
refresh the screen with the current database record values and you will have to reenter your
changes.

Editing Large Fields

To modify the value of a long alphanumeric field (i.e. variable length):

1. Click in the cell of the field to change. The cursor should then appear in the cell.

2. Right-click in the cell and choose the ‘Field Editor’ option.

3. A text entry window will open with the current value displayed.

4. Modify the value and then click the OK button.
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Editing Hexadecimal Values

To modify the hexadecimal values for a field:

1. Click in the cell of the field to change. The cursor should then appear in the cell.

2. Right-click in the cell and choose the ‘Hex Editor’ option.

3. A hex editor window will open with the current value displayed.

4. You can modify the hex value for each character in the field and then click the OK

button.

Setting Null Values

To set a null-capable field to a Null value, first click in the cell of the field to change. Then right-
click in the cell and choose the ‘Set Null’ menu option. The field value should show ‘Null’ as its
value.

Undoing Changes

To undo changes to a field, press the Escape key before exiting the field. The original field
value will be restored.

To undo changes to a record, press the button on the right side of the toolbar before moving
to another record or pressing the Enter key. The original record values will be restored.

Mass Replacing a Field Value

You can perform a mass replace of a field value across multiple records in a database file.
This feature requires that you have been given ‘Mass Replace’ rights by the Surveyor/400
administrator.
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To perform a mass replace, first apply a filter to select the records by following the
instructions on page "Filtering Records" on page 34. Then right-click the column heading of the
field you want to change and choose the ‘Replace’ option. A dialog will prompt you for the new
value. The name of the field in this example is EDFNAME.

Enter a new value or select another field. Press the OK button to perform the mass replace.

Deleting Records

Using the File Editor, you can delete records in a database file if you have the proper authority.
You can use either of the following techniques to delete records from a database file:

l From multiple record mode, highlight a record by selecting its relative record number

(RRN) with the mouse. You can select multiple records by holding down the control or

shift key while clicking the RRNs with the mouse. To delete the selected record(s),
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either click the toolbar button or right-click the record’s RRN and choose the ‘Delete

Selected’ menu option.

l From single record mode, click the toolbar button to delete the record.

Mass Delete

You can delete either a filtered set of records or all the records in a database file. This feature
requires that you have been given ‘Mass Delete’ rights by the Surveyor/400 administrator.

To perform a mass delete of a filtered set of records in the file, first apply a filter to select the
records you want to delete by following the instructions on page "Filtering Records" on
page 34. Then select the ‘Options’ drop down menu and choose the ’Clear File/Filter’ option.

To delete all records in the file, do not apply a filter before choosing the ‘Clear File/Filter’
option.

Audit Logging

An audit trail can be created by Surveyor/400 to log any records added, changed or deleted
through the File Editor. The Surveyor/400 administrator can turn on auditing for your user id or
you can turn it on through the File Editor.

NOTE:

If a Surveyor/400 administrator enabled auditing for your user id, then only an
administrator can turn it back off.

To enable auditing within the File Editor, select the ‘Edit’ drop-down menu and choose the
‘Preferences’ option.

Audit Type

At the bottom of the Preferences screen, you can choose to perform audit logging to either a
Spooled File or a Database file.
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If you choose the ‘Spooled File Auditor’ option, then you should specify the output queue for
storing the auditing spooled files. For each File Editor session, a separate spooled file will be
created. The name of the spooled file will be SFEAUDIT. Leaving the Output Queue field blank
indicates that your default output queue will be used.

If you choose the ‘Database File Auditor’ option, then you should specify the name of a
database file name to store the audit entries into. This auditing file will be created by
Surveyor/400 the first time it is used. See appendix A for the field layout for the auditing
database file.

Audit Options

After specifying an Audit Type, you can then click the ‘Audit Options’ tab to choose between
record or field-level auditing:

Record Level
Auditing

For each record added/changed/deleted: An audit log entry will be
created with the complete record image. The fields in the image will be
separated with a pipe | character.

Field Level
Auditing (Show all
Fields)

For each record added/changed/deleted: An audit log entry will be
created for each field in the record.

Field Level
Auditing (Show
only changed
Fields)

For each record changed: An audit log entry will be created for each
field changed. Additions/deletions will be logged.
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Spooled File Example of an Auditing Log:

User: BLUEBBE Library: SURVEYOR File: DEMO Member: DEMO Format:

DEMORAudit Type: Changed Fields

**** UPDATE RECORD:  2005-01-11 21:39:56.555 ****

RRN: 3

Field: EDLNAME

Before: Lavar

After:  Blacksmith
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Saving a Layout
Once a Layout is defined in the File Editor, the Layout can then be saved and reused in the
future. A saved Layout will store any filter criteria defined, any custom sorting defined and
screen changes (such as rearranged columns, resized columns, renamed headings, hidden
fields and protected fields).

Layouts are stored within a central database on the IBM i and can be shared with authorized
users.

You can save a File Layout by clicking the toolbar icon or by choosing ‘Save Layout’ or ‘Save
Layout As’ from the File menu. A dialog will prompt for the Layout’s name and description.

(Example of Saving a Layout)

A Layout name must be unique and can be up to 20 characters. An optional description (up to
40 characters) can also be entered to describe the Layout.
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Layout Authority
By default, a Layout will be available to any users which have Public Layout Authority. If you
want to restrict access to a Layout, the Layout Authority screen can be used to specify the
users who have authorities for the Layout. There are two methods to access the Layout
Authority screen:

l When saving the layout for the first time, click the ‘Set Layout Authority’ checkbox.

l Open the Layouts folder from the Visual Tree, then right-click the desired Layout and

select the ‘Properties’ menu option. Then click the ‘Authority’ tab.

The Layout Authority screen will show a list of currently configured authorities for the layout.
This screen can be scrolled to the right for viewing more details on the user authorities.

A series of buttons are listed on the bottom of this screen for working with the authorities:

View Opens the selected authority record in view mode.

Add Prompts for values for adding a new authority record.

Edit Opens the selected authority record in edit mode.

Delete Deletes the selected authority record.

Close Closes the screen.
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Adding/Editing a Layout Authority Record

After selecting the ‘Add’ or ‘Edit’ button from the Layout Authority screen, a dialog will prompt
for the values for the authority record.

Using the drop-down box on the top of screen, select the user or group to set authorities for.
On the bottom of the screen, authorities can be turned on/off by clicking the check boxes
within the various tab panels. After completing the information, click the ‘OK’ button to save
the authority record.

Listed below is a description of the fields within the Layout Authority dialog.

Surveyor User Guide www.fortra.com page: 53



/ Layout Authority

Layout Authority - Management tab

Exclude User cannot use the Layout.

Modify Layout Authority User can modify the authority for the Layout.

Delete Layout User can delete the Layout.

Update Layout User can overwrite the Layout with changes.

NOTE:

By default, any user with ‘Public Layout Authority’ can utilize the layout. To restrict public
access to the layout, edit the *PUBLIC authority record and click the ‘Exclude’ check box.

Layout Authority - Records tab

Add Records User can add records to the database file using this Layout.

Change Records User can change records in the database file using this Layout.

Delete Records User can delete records in the database file using this Layout.

NOTE:

A Layout cannot give a user more database editing rights than which they are granted in
the Surveyor/400 User Access screen. For instance, you cannot give a user rights to add
records through a layout if that user was not given File Editor ‘Add’ rights in the User
Access screen.
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Layout Authority - Layout tab

Modify Filter User can modify any Filter settings in the Layout.

Open
Without
Filter

User can open the Layout without the Filter applied.

Modify Field
Layout

User can access the Modify Layout screen in the File Editor. the field layouts
(i.e. unhide fields, unprotect fields, change column headings).

Modify
Visible
Fields

User cannot modify the Restrict Visible column in the Modify Layout screen or
make any Restricted Visible fields visible.

Modify
Protected
Fields

User cannot modify the Restrict Protected column in the Modify Layout screen
or make any Restricted Protected fields unprotected.

Modify Filter
Fields

User cannot modify the Restrict Filter column in the Modify Layout screen or
make any Restricted Filter fields visible.

Layout Authority - Transfer/Select tab

Export
Records

User can export database records using the Layout.

Print Records User can print database records using the Layout.

Select
Members

User can select different members in the database file when using the 
Layout.

Select
Formats

User can select different record formats in the database file when using the
Layout.
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Opening a Layout
File Layouts can be located and opened using either the Layout Manager or the Visual Tree.

NOTE:

Users can only access Layouts in which they have authority to.

Using the Layout Manager

The Layout Manager can be accessed from two different locations:

l Within the File Editor, select the ‘File’ menu and choose ‘Open Layout’.

l From the Surveyor/400 screen, select the ‘Tools’ menu and choose ‘Layouts’.

Within the Layout Manager, you can search for File Layouts using one or more filter values.
After keying in the filter values, press Enter to view a list of File Layouts which meet the
criteria. You can then double-click a File Layout in the list to open it.

Using the Layouts folder in the Visual Tree

From the main Visual Tree component, you can expand the ‘Layouts’ folder to view a list of File
Layouts.

To locate a Layout, you can sort the list of layouts in a different order by clicking the column
heading to sort.

Double-click the Layout to open it in the File Editor.

Surveyor User Guide www.fortra.com page: 56



/ Opening a Layout

Surveyor User Guide www.fortra.com page: 57



/ Layout Management Functions

Layout Management Functions
File Layouts can be copied, renamed and deleted by authorized users. To perform these
management functions, first use one of the methods below to open a list of layouts:

l From the main Surveyor/400 screen, select the ‘Tools’ menu and choose ‘Layouts’.

l From the Surveyor/400 Visual Tree component, expand the ‘Layouts’ folder.

l Within the File Editor, select the ‘File’ menu and choose ‘Open Layout’.

A list of authorized Layouts will be displayed. To work with a particular File Layout, right-click
the Layout to view the available menu options.

Renaming a Layout

To rename a Layout or change its description, choose the ‘Rename/Change Desc’ option from
the right-click menu.

A dialog will prompt for the Layout name and description. Make any changes and press enter.

NOTE:

A Layout can only be renamed by a Surveyor/400 Administrator or by a user with ‘Update
Layout’ authority.
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Deleting a Layout

To delete a Layout, choose the ‘Delete Layout’ option from the right-click menu. A confirmation
dialog will be displayed. Click the ‘Yes’ button to confirm the deletion.

NOTE:

A Layout can only be deleted by a Surveyor/400 Administrator or by a user with ‘Delete
Layout’ authority.

Copying a Layout

With the Copy Layout function, a Layout can be renamed, based over a different database
file/member and/or copied to another IBM i system or LPAR.
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To copy a layout, choose the ‘Copy Layout’ option from the right-click menu. A dialog will
prompt for the target information. A description of the fields is listed below:

l System – Specify the target IBM i system to copy the Layout to.

l Layout Name – Specify the name of the Layout to create.

l Layout Description – Specify the description of the new Layout.

l Library – If you want to base the Layout over a different database file, then specify the

library where it is located.
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l File – If you want to base the Layout over a different database file, then specify the file

name.

l Member – If you want to base the Layout over a different member, then specify its

name.

NOTE:

A layout can only be copied by a Surveyor/400 Administrator or by a user with all
authorities to the Layout.

Duplicating a Layout

Duplicating a layout is like copying a layout except only the layout name and description can be
changed. You can define 'Authorities for Duplicate'. These will be the authorities the layout will
receive when duplicated. The idea is that a user can create a layout and restrict users from
changing the layout, but give them the ability to duplicate the layout with additional authorities.
The user will be able to use the duplicated layout but leave the original intact. The original acts
like a template.
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Export Wizard
Surveyor/400's Export Wizard allows you to quickly select and export (download) database
records using intuitive graphical wizards. Exported records can be targeted to your
workstation, a mapped network drive, the Integrated File System (IFS) or another database file.
Supported export formats include Excel, Excel 2007, XML, fixed width, delimited text and
HTML.

The Export Wizard can be opened using one of these methods:
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l Right-click a file and choose the ‘Export’ option.

l Open the Fast Path dialog, key in a file and library, then click the ‘Export’ button.

l Click the icon on the main toolbar.

l Choose the ‘Export Data’ option from the ‘Tools’ menu.

After the export wizard is opened, follow the steps below to define and execute an export:

Step 1: Source File Information

a. Select the IBM i from the System drop-down list.

b. For the ‘Library’, key in the Library name or click the button to perform a lookup.

c. For the ‘File, key in the name of a table, view, physical or logical file. Optionally click the

button to perform a lookup.

d. For the ‘Member’, specify *FIRST to choose the first member in the file. Optionally key in

the name of a member or click the button to perform a lookup.

e. If you want to select certain records or fields from the file, select the ‘Use the query

below’ checkbox. You can either key in a free-form SQL Select statement in the text box

or click the ‘Start SQL Wizard’ to use a wizard to build the SQL statement.

Step 2: Destination File Information

a. Select the desired export format from the drop-down list:

l Delimited – Creates a text file, in which the fields are delimited by a special

character. The default delimiter is a comma, which can be changed on the ‘Next’

screen.

l Fixed Width – Creates a text file, in which the fields are placed into fixed positions

in the file. The column widths can be specified on the ‘Next’ screen.

l HTML – Creates an HTML document, in which the fields will be placed within a

table component. The field names will be used as the table column headings.

l XML – Creates an XML document. The XML formatting options can be specified

on the ‘Next’ screen.

l Excel – Creates an Excel document.
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l Excel 2007 – Creates an Excel 2007 document.

l Database – Exports records to another DB2/400 database file.

l (Flat) - Flat is not an actual Export File Format, but you can export a flat file by

following the below steps.

a. Select Delimited, as the File Format. Press the Next button.

b. On Step 2 choose Delimiter 'Other'. A field will become enabled, which is for

entering a delimiter, leave this field empty.

c. Uncheck the 'Include column names or headings in the first row' box.

d. Press the Advanced button and select 'NONE' for the 'End of record' option.

b. Choose if the output file should be placed on your workstation or the IBM i IFS.

c. Click the button to specify a file name.

Step 3: Export Options (optional)

You can customize the export options by clicking the “Advanced” and "Next" buttons.

The following can be specified by clicking the Advanced button:

Value Comments

Date Format to use for date fields Default is yyyy-mm-dd

Date Delimiter to use for date
fields

Default is /

Decimal Symbol Default is a period

NULL Substitute value For null-capable fields

End of Record control character Default is a carriage return and a line feed

Number of Records to Export Leaving blank will not limit the number of records
exported
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The following can be specified by clicking the Next button:

l Delimiter – For a Delimited file, select the field delimiter from the drop-down list or

select ‘Other’ and enter a delimiter character in the text box on the right.

l Text Qualifier – For a Delimited file, select either a single quote or a double quote to

place around alphanumeric data.

l Include column headings in the first row – Specify if the first row of the exported data

should include the column headings.

l Append record(s) to the file – Specifies if the exported data will either Replace the data

in the destination file or Append to the end of an existing file.

l Field Length – For a Fixed Width file, you can change the lengths of the fields by

clicking the lengths and keying in different values.

l For an XML document, you can specify these additional options:

o Include XML header tag

o Include column tags

o Include empty data tags

o Select a style to replace special characters: HTML or ASCII character style

l For Database export format, you can specify these additional options:

o Specify the destination IBM i system, library, database file and member name.

o Click the ‘Load Target Fields’ button to retrieve the field names from the

destination database.

o On the lower part the screen, you can then map the source and destination fields

by name or by relative position in the file.

Step 4: Execute

When you are ready to export the data, click the button at the bottom of the screen.
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A bar will indicate the progress of the data export. When the export is completed, it will
indicate the number of records that were exported. 

Step 5: Saving the Export Specifications (optional)

If you plan to use the export specifications again at a later time, the specifications can be
saved to your workstation or the IBM i IFS.

a. Select the ‘File’ menu at the top of the screen.

b. Select ‘Save Specs’ to save the specifications to the workstation. Choose ‘Save Specs’

to save the specifications to the IBM i IFS.

c. Specify the file name and directory to store the specifications file in.

TIP:

A data export can be automated from either the workstation or the IBM i . Read the
instructions starting on page "Advanced Transfers and Automation" on page 132 for more
information.
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Import Wizard
Surveyor/400's Import Wizard allows you to quickly import (upload) Excel and text files into
IBM i database files using graphical wizards. The files to import can be located on the
workstation, a mapped network drive or the Integrated File System (IFS).

The Import Wizard can be opened using one of these methods:

l Right-click a file and choose the ‘Import’ option.

l Click the icon on the main toolbar.

l Choose the ‘Import Data’ option from the ‘Tools’ menu.
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After the import wizard is opened, follow the steps below to define and execute an import:

Step 1: Source File Information

a. Select the format of the source file from the drop-down list:

l Delimited – A text file with fields delimited by special characters. The default

delimiter is a comma, which can be changed on the ‘Next’ screen.

l Fixed Width – A text file with fields stored in fixed positions within the file. The

column widths can be specified on the ‘Next’ screen.

l Excel – An Excel or Excel 2007 spreadsheet.

l Flat – A text file with which contains a single record. This single record is actually

made of many contiguous records. For example, in a delimited format, records

typically have an end of record character such as a 'line feed'. Flat files do not

have end of record character(s). Records will be imported into the first field of the

file specified.

b. Indicate if the source file is located on the workstation (which could also be a mapped

network drive) or the IBM i IFS.

c. Click the button to choose a file name and directory.

Step 2: Destination File Information

a. Select the IBM i from the System drop-down list.

b. For the ‘Library’, key in the Library name or click the button to perform a lookup. [A

new library can be created by clicking the button on the right side, which will

prompt for the library information.]

c. For the ‘File’, key in the name of a table, view, physical or logical file. Optionally click the

button to perform a lookup. [A new database file can be created by clicking the

button on the right side, which will prompt for the file name and the field layout.

Surveyor/400 can automatically determine the field types/lengths by analyzing the data

in the source file.] 
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d. For the ‘Member’, specify *FIRST to choose the first member in the file. Optionally key in

the name of a member or click the button to perform a lookup. [A new member can

be created by clicking the button on the right side, which will prompt for the

member information.]

e. Specify if you want to either Append the imported records to the end of the member or

Replace the records in the member.

f. Optionally click the ‘Advanced’ button to specify advanced options (see next page for

details).

g. Click the ‘Next’ button to open the ‘Source File Details’ screen (see next page for

details).

Step 3: Advanced Options (Optional)

The following import options can be specified by clicking the ‘Advanced’ button.

Value Comments

Date Format Format of the data, when importing into date type fields. Default is yyyy-mm-
dd

Decimal
Symbol

Decimal symbol used in numeric fields within the source file. Default is a
period.

Suppress
Warnings?

A warning message is generated whenever there is a problem importing a
record. For instance, a warning is generated when data from a source field has
to be truncated to fit into the target database field. Check this box to suppress
warning messages.

Substitute
Null for
string?

If you have null-capable fields in the target database file, then check this box
to specify the string value for nulls.

String to
substitute
Null for

If you check the ‘Substitute Null for string?’ field, then specify the string value
which indicates a Null value.
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Step 4: Source File Details

This screen will allow specifying details on how the source data is structured. The bottom
portion of the screen will show the first 20 records in the source file.

Excel import

l Specify if the first row in the Excel spreadsheet contains column headings.

l Specify the row number in the Excel spreadsheet where the data begins.

l Specify the worksheet name.

Delimited text file import

l Specify if the first row in the text file contains column headings.

l Select the field delimiter from the drop-down list or select ‘Other’ and enter a delimiter

character in the text box on the right. Default is a comma.

l Indicate if alphanumeric fields are enclosed within single or double quotes.

Fixed Width text file import

l Specify if the first row in the text file contains column headings.

l Indicate the number of fields to import from the text file.

l Specify the lengths of the fields by clicking in the cells and keying the appropriate

values.

Flat text file import

l Specify if the record length.

Surveyor User Guide www.fortra.com page: 70



/ Import Wizard

Click the ‘Next’ button to specify how the columns should be mapped from the source file to
the target database file (see next page for details).

Step 5: Map Columns

The source field names (column headings) will be listed in the first column of the screen. The
target database field names will be listed in the second column of the screen.

To change the mapping for an individual field, click in the cell of the target field and choose a
field from the drop-down list.

The ‘Map by Field Name’ button will match the target fields to the source fields by name. Any
fields that do not match will be excluded.
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The ‘Map by Field Order’ button will list the target fields in the order in which they appear in the
file.

Click the ‘Exclude’ check box to choose to not import a field from the source file.

Step 6: Execute

When ready to import the data, click the button at the bottom of the screen.

A bar will indicate the progress of the data import. When the import is completed, it will
indicate the number of records which were imported. 

If there are any problems with the import, an error log will be generated (which can be viewed).

Step 7: Saving the Import Specifications (optional)

If you plan to use the Import specifications again at a later time, you can save these
specifications to your workstation or the IBM i IFS.

a. Select the ‘File’ menu at the top of the screen.

b. Select ‘Save Specs’ to save the specifications to the workstation. Choose ‘Save Specs

to IFS’ to save the specifications to the IBM i IFS.

c. Specify the file name and directory to store the specifications file in.

TIP:

A data import can be automated from either the workstation or the IBM i . Read the
instructions starting on page "Advanced Transfers and Automation" on page 132 for more
information.
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Spooled Files
Using Surveyor/400’s Spooled File Manager, IBM i spooled files can be quickly located, viewed,
exported and managed. The Spooled File Manager can be opened using one of these methods:

l Click the icon on the main toolbar.

l Choose the ‘Spooled File Manager’ option from the ‘Tools’ menu.

Finding Spooled files

To find spooled files created by your user profile, leave the User set to *CURRENT and click the
‘Load’ button.

You can change the user or specify additional search criteria on the other filter tabs, including
Output Queue, Job, Spooled File Name, User Data, Form Type, Status and Creation Date.

For instance, to find all spooled files in the QPRINT output queue:

1. Change the User to *ALL

2. Click the ‘Output Queue’ tab
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3. Key in the value ‘QPRINT’

4. Click the ‘Load’ button

Viewing a Spooled file

To view a spooled file shown in the list, either 1) double-click the file with the mouse or 2) right-
click the file and select the ‘View’ option. The first page of the spooled file contents will be
displayed.

You can page through the spooled file by either using the arrows at the bottom of the screen or
by pressing the page up/down keys.

A text string can be found in a spooled file by selecting the ‘Search’ menu option and then
‘Find’.

Exporting Spooled files

To export one or more spooled files into PDF or Text format, perform one of the following
actions:
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l When viewing a spooled file’s contents on the screen, click the toolbar button or

l When presented with a list of spooled files on the search screen, highlight one or more

spooled files and then right-click and choose the ‘Export’ option.

TIP:

When viewing a spooled file, a particular page can be exported by selecting the ‘Tools’
menu option and then select ‘Export Current Page’.

The spooled file export wizard will open. Follow these steps to perform the export:

1. Choose a file format of PDF or Text.

2. Specify if the file should be created on the workstation or the IFS (Integrated File

System).

3. Specify the name of the file and directory by clicking the browse button.
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4. By default, Surveyor/400 will utilize predefined criteria (i.e. font sizes, margins, etc.) to

automatically fit a spooled file into a PDF file. To specify your own custom criteria for

creating the PDF, click the ‘Next’ button.

5. Click the ‘Execute’ button to perform the export.

6. After the spooled file is exported, you can choose to view the exported file on the

screen.

TIP:

Exporting of spooled files can be automated from the IBM i . Read the instructions starting
on page "Advanced Transfers and Automation" on page 132 for more information.

Managing Spooled files

Perform a right-click a spooled file to view a list of Surveyor/400 spooled file management
actions:

l View – View the spooled file.

l Properties - Displays the general attributes of the spooled file, such as its status, date

created and printing instructions.

l Hold - Prevents the printing of a spooled file by holding it on the output queue.

l Release – Releases a held spooled file so it can print.

l Delete – Removes an unneeded spooled file from the output queue.
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l Move – Allows you to move the spooled file into a different output queue/library.

l Copy – Allows you to copy the spooled file into a different output queue/library.

l Copy to Filter – Allows you to copy spooled file attributes to the filter.
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.5250 Emulator
The included 5250 Emulator allows users to start IBM i hosts sessions from within the
Surveyor/400 product.

This 5250 emulator is full-featured with support for custom colors, fonts, 132 columns,
keyboard mapping, named devices, keyboard macros and rulers.

Follow the instructions below to use and configure the 5250 Emulator.

1. The 5250 Emulator can be started using one of these methods:

l Click the icon on the main toolbar.

l Right-click an IBM i system in the visual tree and choose the ‘TN5250’ option.

2. A screen will prompt for connection information:
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3. Select the IBM i system to connect to.

4. Choose either an auto-named device or create a new device by pressing the ‘New

Device’ button.

5. Press the Port/SSL button if an SSL connection is desired. See configureSSL

6. When done, press the ‘Ok’ button. You will then be presented with a sign on screen for

the IBM i .

7. Enter the IBM i user profile and password to sign on.

A row of toolbar icons are available on the top of the emulator screen. You can position the
mouse over an icon to view a pop-up description on it. Listed below is a description of the
emulator icons:

For configuring screen fonts styles, sizes, column separators, macro directory, etc.

Allows the user to remap the keyboard

Changes the cursor between a block and underline

Turns on/off a Crosshair ruler

Prints the screen to a local printer
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Copies the selected region into the clipboard (you can select a region by drawing a box
around the text with the mouse)

Cuts the selected region into the clipboard

Pastes clipboard contents into the screen

Allows selecting ‘Reset’, ‘Attention’ and ‘System Request’ keys

Starts/stops recording a keyboard macro

Plays the current keyboard macro

Plays a new keyboard macro

Allows the user to change the screen text and background colors

Configuring an SSL Connection

l Configure the Telnet server

l Select an SSL Type. TLS is the most common. This will automatically change the port

to 992, which is the default SSL port.

l Import a certificate. There are two ways to import a certificate.

l After selecting an SSL type, simply try to connect to the system. The SSL telnet

server will send a certificate and the user will be prompted to trust the certificate.

l Or import the certificate from a text file. Press the 'Certificate Manager' button,

then press the 'Import' button. Note: First you must obtain the certificate. If you

are using DCM, use the 'Install Local CA Certificate on Your PC - Copy and paste

certificate' option.

NOTE:

When you make an SSL connection the list of certificates is automatically searched.
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TIP:

You can access the Surveyor/400 File Editor and Properties graphical components from
the emulator’s command line. Use the command SFE for the File Editor and SP for
properties. Both commands are located in the SURVEYOR library.
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Advanced Database Tools
SQL Editor
Surveyor/400’s SQL Editor allows you to enter and execute SQL statements for database files
on the IBM i . Statements can be entered in free-form fashion or can be generated using a
comprehensive Wizard. Any database result sets can be viewed, printed and downloaded to
your workstation. SQL statements can be saved to either the IBM i or to your workstation for
future execution.

The Surveyor/400 SQL Editor can be opened using one of the following methods:

l Right-click a file and choose ‘Run SQL’.

l Open the Fast Path dialog, key in a file name and library, then click the ‘Run SQL’

button. A pre-formatted SQL statement will be built for you.

l Click the icon on the main toolbar.

l Choose the ‘SQL Editor’ option from the ‘Tools’ menu.
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Entering Free Form SQL Statements

SQL Statements are entered in the text area at the top of the SQL Editor screen. Any valid
DB2/400 SQL statement can be entered (as long as the user is authorized), including SELECT,
UPDATE, DELETE, INSERT, CALL and CREATE statements.

Multiple statements can be entered for creating a SQL script. If multiple statements are
entered, a semi-colon must be placed at the end of each statement.

TIP:

To perform a field lookup, position the cursor on the file name and press the F4 function
key. Field(s) can then be selected to insert within the statement.

Comments can be placed within the SQL script by enclosing the text with a /*  */  (e.g. /*
Command comment */). Blank lines are allowed within the SQL script.

EXAMPLE:

/* Update Zip Code for Ashland */

UPDATE surveyor.demo

SET zip = '73613'

WHERE city = 'Ashland';

/* Update Zip Code for Greenwood */

UPDATE surveyor.demo

SET zip = '64342'

WHERE city = 'Greenwood';

When entering library and file names, you can choose to use a period or a slash as the
separator. To use a period (i.e. LIBRARY.FILE), select the ‘SQL Naming’ option on the toolbar.
To use slashes (i.e. LIBRARY/FILE), select the ‘System Naming’ option.
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Instead of qualifying file names (i.e. LIBRARY.FILE) within SQL statements, a library list can be
specified to search within the ‘Library List’ field, which is located in the top-right corner of the
screen. Libraries should be separated by commas (i.e. LIB01, LIB02, LIB03).

Creating Statements with SQL Wizard

Surveyor/400's SQL Wizard provides intuitive screens for generating SELECT, INSERT, UPDATE
and DELETE statements. The wizard includes dialogs which a user can use to select tables,
fields, where criteria, join information and order-by criteria.

To launch the SQL Wizard, click the icon (located on the SQL Editor toolbar).

Step 1: Select Tables

1. Choose the type of statement to create by clicking the appropriate radio button - Select,

Insert, Update or Delete.

2. Select the IBM i system from the drop-down list.

3. Key in the Library name or click the button to perform a lookup. *LIBL and *USRLIBL

are also supported.
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4. If you know the name of the file, then key its name next to the “Table/View” heading

and press enter. The name will then appear in the “Selected Tables/Views” section on

the right half of the screen.

--or--

If you want to browse for files in the library, then click the “Load Tables/Views” button.

You can then double click the files(s) you wish to choose.

5. Click the Next> button to proceed to the next screen.

Step 2: Select Columns

Columns (fields) can be selected on the left side of the screen. As columns are selected, they
will be moved to the “Selected Columns” section on the right side of the screen. Columns can
be selected using one of the following methods:

l Double click a single column name.

l Click one or more column names and then click the > button. More than one column

name can be chosen by holding down the control or shift key.

l Custom Name – Enter optional headings.

l Choose all columns by clicking the >| button.

l Click the Next> button to proceed to the next screen.
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Step 3: Specify Additional Criteria

This screen is broken out into 4 panels. Click the tab of the desired panel and specify the
criteria needed:

l Where – for filtering the records

l Join – for joining multiple tables together

l Order By – for sorting the records

Click the ‘Done’ button to generate the SQL Statement.

Step 4: Edit/Run Query

After clicking the ‘Done’ or ‘Copy to Editor’ button, the generated SQL statement will be placed
within the SQL Editor window. This statement can then be edited, executed or saved.

Executing SQL

SQL Statement(s) can be executed by clicking the Execute toolbar icon or the F5 function
key. To execute only certain statements within a script, highlight the statement(s) and click the
Execute button.

Surveyor User Guide www.fortra.com page: 86



Advanced Database Tools / SQL Editor

You can choose which IBM i system to run the SQL Statements for by choosing the desired
system from the drop-down list box on the top left corner.

NOTE:

A Surveyor/400 administrator can restrict a user from running certain types of SQL
statements. For instance, a user could be given authority to only execute query (select)
statements so they cannot run any statements that modify data. This is controlled in the
Surveyor/400 User Access Manager.

SQL Results

If a result set was generated by the execution of a Select or Call statement, this result set will
be displayed in a new window.

Click the arrow buttons at the bottom of the screen to move through the result set.

A page of the result set can be printed by clicking the toolbar icon.
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The entire result set can be exported in Delimited, Fixed Width, HTML, XML, Excel, or Database
formats Click the toolbar button to initiate the export process.

SQL Log

The SQL Log is located on the bottom half of the screen. Any SQL statements executed (along
with any corresponding messages) will placed be in the log. SQL Statements are colored in
blue, Success messages are colored in green and Errors are colored in red.

SQL Statement(s) can be copied from the log by highlighting the statement in the log and
pressing Ctrl+C. Then place the cursor in the SQL editor and press Ctrl+V to paste the
statement(s).

If you want to clear the SQL log, click the ‘Clear Log’ button.

Saving and Opening Scripts

To save a SQL script to your workstation, click the toolbar icon. You will be prompted to
specify the directory and name for the script.

To open an existing script file, click the icon and choose the name of the script to open.

A SQL script can also be saved into a source member on the IBM i by selecting the ‘Save As
Member’ option under the ‘File’ menu. Specify the source file and member name. The script
can subsequently be opened from a source member by selecting the ‘Open Member’ option
under the ‘File’ menu.

TIP:

If a SQL script is saved into a source member on the IBM i , this script can be run natively
from the IBM i using the IBM command of RUNSQLSTM.

Sample SQL Statements

The SQL wizard is a good tool for building basic Select, Update, Delete and Insert statements.
However, if you need to build more sophisticated SQL statements, you can access the
extensive collection of sample SQL statements supplied with Surveyor/400.
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Follow the instructions below to browse and select these sample SQL statements:

1. Click the toolbar icon.

2. A list of sample SQL statements will be displayed.

3. Scroll through the list until you find a SQL statement to utilize.

4. Highlight the SQL statement you are interested in and press either the 'Copy to Editor'

button or the 'Done' button. Both will copy the statement to the SQL Editor window. The

'Done' button will close the Sample window and 'Copy to Editor' leaves it open. You may

also Copy text by highlighting the text and selecting the 'Copy' option from the 'Edit'

menu or a right-click menu. The text is then available for pasting.

5. This statement can then be tailored to your needs.
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Generate SQL

The Generate SQL function allows you to reverse-engineer DB2/400 tables (physical files) into
their corresponding DDL source code (Create Table statements). The Generate SQL screen can
be opened using one of these methods:

l Right-click a file and choose the ‘Generate SQL’ option.

l Open the Fast Path dialog, key in a file and library, then click the ‘Generate SQL’

button.

l Choose the ‘Generate SQL’ option from the ‘Tools’ menu.

Follow the steps below to use the SQL Generator function:

1. To choose more tables on this screen:

a. Specify the library name and then click the ‘Load’ button.

b. A list of tables will be displayed on the left side of the screen.

c. Double-click the tables you wish to select for reverse-engineering.

2. Click the desired check boxes for customizing the resulting DDL source:

l Include Primary Keys

l Include Foreign Keys

l Include Unique Keys

l Include Labels

l Include Headings

l Include Indices

3. Click the ‘Generate SQL’ button on the bottom of the screen.

4. A dialog will prompt for the library name, which will be used for qualifying the table

name(s) within the generated SQL statement(s). Either choose to keep the same library

name or specify a different library and press enter.
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5. A dialog will prompt to save or open the script. If you choose to save the script, you will

be prompted for the directory and file name. If you choose to open the script, then the

script will be displayed within the SQL Editor. From within the SQL Editor, you can make

any additional changes to the script and save or execute it.

Generate DDS
The Generate DDS function allows you to reverse-engineer DB2/400 tables (physical files) into
their corresponding DDS source code. This is especially useful if a file's DDS (Data Description
Specifications) has been lost or is not up to date.

The Generate DDS screen can be opened using one of these methods:
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l Right-click a file and choose the ‘Generate DDS’ option.

l Open the Fast Path dialog, key in a file and library, then click the ‘Generate DDS’

button.

l Choose the ‘Generate DDS’ option from the ‘Tools’ menu.

After choosing the option, the generated DDS will then be shown on the screen. Example:

Click the ‘Reference Data?’ checkbox if you want the fields to refer to the field reference file
which was used when the file was created (versus having the field types/lengths defined
directly in the source).

Click the ‘Save’ button to save the DDS to a source member. You will be prompted to specify
the source file name and member. You will also be given the option to update the file object
with the location of the source member.

NOTE:

Due to intrinsic differences between DDS and SQL, the DDS generated may not be 100%
accurate if the file was initially created using the SQL Create Table statement.
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Table Maintenance
Surveyor/400 allows authorized users to quickly create, alter and drop tables on the IBM i .

Creating a Table

A database table can be created using the Surveyor/400 graphical Table Wizard. The table can
be created either immediately or at a later time (by saving the generated SQL script). Follow
the instructions below to use this function:

1. The table wizard can be launched using one of these methods:

l Right-click a library and choose the ‘Create -> Table’ menu option OR

l From the main ‘Tools’ menu, choose the ‘Create -> Table’ menu option.

2. A dialog will prompt for general information about the table. Key in the library name,

table name and remarks (description). Then click the ‘Next’ button.

NOTE:

A Surveyor/400 administrator can control user authority to these maintenance functions
with the ‘Allow Database Maintenance’ flag in the User Access screen.

3. A screen will prompt for defining the columns (fields) in the table. Define each column

in the table as a separate row on the screen.
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4. Optional – Click the Edit button for a selected column to edit the column definition

vertically. Any attributes unique to this data type are displayed. For example for type

'Character' you can define an 'Encoding' type.

5. Optional - Click the ‘Advanced’ button to specify any Primary Keys, Unique Keys, Foreign

Keys or Indexes for the table.

6. Click the ‘Create’ button to create the table.

TIP:

To show the SQL script that will be used to create the table, click the ‘Show SQL’ button to
launch the SQL Editor. The script can then be modified and/or saved to be run at a later
time.

Altering a Table

The Surveyor/400 Table Wizard can be used to alter a definition for a table. This wizard can be
used to create and modify a database table’s Columns, Primary Keys, Unique Keys, Foreign
Keys and Indexes.

The Table Wizard can be opened using one of these methods:

l Right-click a table and choose the ‘Alter’ option.

l Open the Fast Path dialog, key in a file and library, and then click the ‘Maintain’

button. Then click the ‘Alter Table’ option.
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The wizard will show the current columns in the table.

To add a new column to the table, click the ‘Add Column(s)’ button. Key in the column
information within the dialog and press enter.

To modify an existing column in the table, select the column and click the ‘Modify Column’
button. Specify the changes for the column and press enter.

To delete an existing column from the table, select the column and click the ‘Drop Column’
button.

Click the ‘Advanced’ button to work with the Primary Keys, Unique Keys, Foreign Keys and
Indexes for the table.

Dropping a Table

A table can be dropped (deleted) using one of these methods:

l Right-click a table and choose the ‘Delete’ option.

l Open the Fast Path dialog, key in a file and library, and then click the ‘Maintain’

button. Then click the ‘Delete Table’ option.

Any dependent indexes (logicals) for the table will also be removed.
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Stored Procedures
Surveyor/400 can be used to quickly create, view, modify, copy and execute Stored Procedures
on the IBM i .

Creating a Stored Procedure

A stored procedure can be created using the Surveyor/400 graphical Stored Procedure Wizard.
The stored procedure can be created either immediately or at a later time (by saving the
generated SQL script). Follow the instructions below to use this function:

1. The Stored Procedure Wizard can be launched using one of these methods:

l Right-click a library and choose the ‘Create -> Procedure’ menu option OR

l From the main ‘Tools’ menu, choose the ‘Create -> Procedure’ menu option.

2. Choose to create the Stored Procedure using either an External program or SQL

statements.

3. A wizard will prompt for the stored procedure values.

4. Specify the IBM i system, library name and procedure name. Complete the remaining

fields in the wizard as needed for the stored procedure, including any parameters.
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5. Click the ‘Create’ button to create the stored procedure.

TIP:

To show the SQL script that will be used to create the stored procedure, click the ‘Show
SQL’ button to launch the SQL Editor. The script can then be modified and/or saved to be
run at a later time.

Viewing Stored Procedures

Existing stored procedures can be viewed through the Surveyor/400 Visual Tree, Library
Properties, or SQL Search. Follow the instructions below to view the stored procedures in a
library:

1. Double click the IBM i on the left panel to connect to it.

2. Double click the Database folder under the IBM i .

3. A list of libraries will be displayed.

4. Double click the desired library to open it.

5. Double click the ‘Stored Procs’ folder to view the stored procedures within the library.
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6. Scroll to the right to view more details about the stored procedures. Additionally you

can view the details by right-clicking a stored procedure and selecting ‘Properties’.

Editing a Stored Procedure

A stored procedure can be modified using the graphical wizard. Surveyor/400 will
automatically drop and recreate the stored procedure using the wizard values. Follow the
steps below to modify a procedure:

1. Right-click a stored procedure and choose the ‘Edit’ option.

2. A wizard will show the current values for the stored procedure.

3. Make any changes and click the ‘Save’ button to recreate the stored procedure with the

new values.

Copying a Stored Procedure

A stored procedure can be copied to another procedure name, another library or to another
IBM i system. Perform the following steps to perform the copy function:

1. Right-click a stored procedure and choose the ‘Copy’ option.

2. A wizard will show the values for the stored procedure.
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3. Specify the new Procedure name, IBM i system, library and any other changes.

4. Click the ‘Save’ button to create the new procedure.

Deleting a Stored Procedure

To delete a stored procedure, right-click it and choose the ‘Delete’ option.

Calling a Stored Procedure

A stored procedure can be called through Surveyor/400. If the stored procedure has input
parameters, then Surveyor/400 will prompt for those parameter values. Any result sets
generated by the stored procedure can be viewed, printed and downloaded.

Follow the steps below to call a stored procedure:

1. Right-click a stored procedure and choose the ‘Execute’ option.

2. Specify any parameter values under the ‘Value’ column.

3. Click the ‘Execute’ button to run the stored procedure.

4. Any result sets will be shown in a new window. A result set can be paged through,

printed or exported into various PC formats.

5. From the results set the parameters can be displayed by clicking the procedure name.
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SQL Functions
Surveyor/400 can be used to quickly create, view, and modify SQL Functions on the IBM i .

Creating a Function

An SQL function can be created using the Surveyor/400 graphical SQL Function Wizard. The
function can be created either immediately or at a later time (by saving the generated SQL
script). Follow the instructions below to use this feature:

1. The SQL Function Wizard can be launched using one of these methods:

l Right-click a library and choose the ‘Create -> Function’ menu option OR

l From the main ‘Tools’ menu, choose the ‘Create -> Function’ menu option.

2. Choose to create the SQL Function using either an External program or SQL

statements.

3. A wizard will prompt for the SQL Function values.

4. Specify the IBM i system, library name and function name. Complete the remaining

fields in the wizard as needed for the SQL Function, including any parameters.

5. Click the ‘Create’ button to create the SQL Function.
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Viewing SQL Functions

Existing SQL Functions can be viewed through the Surveyor/400 Visual Tree, Library
Properties, or SQL Search. Follow the instructions below to view the SQL Functions in a library:

1. Double click the IBM i on the left panel to connect to it.

2. Double click the Database folder under the IBM i .

3. A list of libraries will be displayed.

4. Double click the desired library to open it.
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5. Double click the ‘Functions’ folder to view the SQL Functions within the library.

6. Scroll to the right to view more details about the SQL Functions. Additionally you can

view the details by right-clicking a SQL Function and selecting ‘Properties’.

Editing an SQL Function

An SQL Function can be modified using the graphical wizard. Surveyor/400 will automatically
drop and recreate the SQL Function using the wizard values. Follow the steps below to modify
a function:

1. Right-click a SQL Function and choose the ‘Edit’ option.

2. A wizard will show the current values for the SQL Function.

3. Make any changes and click the ‘Save’ button to recreate the SQL Function with the new

values.

Deleting an SQL Function

To delete an SQL Function, right-click it and choose the ‘Delete’ option.

Additional Developer Tools
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Additional Developer Tools
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Object Search
Surveyor/400 allows you to quickly find objects on the IBM i using a variety of search criteria,
providing many more options than IBM’s WRKOBJ command. Any search criteria can be saved
for future use.

To access the Object Search, click the toolbar icon on the main Surveyor/400 toolbar.

By default, the ‘High Detail’ option will be selected at the top of the screen. This option allows
specifying advanced search criteria (date/size/user) and will show more detail for returned
objects. The ‘Low Detail’ option offers less criteria, but it slightly faster than the ‘High Detail’
option.

Searching for objects

Over a dozen different search criteria can be specified through the various tab panels. Each
tab in the Object Search screen is an additional filter which narrows your search:
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Basic Search

Specify an Object name, Library, Type and/or IBM i to search. Object can be a
specific name, *ALL or a generic name (by keying a partial name with an asterisk *
in front and/or behind it). The Library can be a specific name or a library list.

TIP:

Specify *CUST* in the Object to find any objects which have the word CUST
within the name.

Attribute Search

For finding objects with a certain attribute. For instance, choose the DSPF attribute
to search for Display File objects.

Description Search

For finding objects which have the specified text in the object’s description.

Date Search

For finding objects Created, Modified, Saved, Not Saved, Last Used and Not Used
within a certain time frame or within a duration of days.

TIP:

For system cleanup, the “Not Used” option is a quick way to find unused
objects.

Size Search

For finding objects which meet a minimum size, maximum size or are within a size
range.

User Search

For finding objects created by a particular User id.
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After specifying the search criteria, click the “Search” button to execute the search process.
The amount of time to perform the search depends on a number of variables, including the
scope of your search and your IBM i performance. For instance, results will be returned faster
when searching a specific library name, versus *ALL libraries.

TIP:

An actively running search can be canceled by pressing the Escape button on your
keyboard.

NOTE:

Specifying an Object value of *ALLUSR, Library value of QSYS or *LIBL, and a Type of *LIB
will produce a list of *ALLUSR libraries.

Working with the Object List

After the search finishes, a list of objects meeting the filter criteria will be displayed.

You can scroll the object list to the right for viewing more information about the objects. You
can also use the mouse to resize or move columns in the list of objects displayed.

By right-clicking any column heading in this list, you can choose menu options to hide/show
columns, search a column, sort a column, print the list or export the list to the clipboard or a
PC format.

Right-Click Menu Options

When you see the object you want to work with, you can right-click it to display a list of menu
functions to perform. For instance, click the “Edit” option to work with the records in a
database object.
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Saving the Search Criteria

To save the search filter for future use, click the toolbar icon. Provide a name for the filter
and press enter. The filter can be subsequently opened by clicking the toolbar icon.

Saved filters can also be executed from within the Surveyor/400 Visual Tree. Listed below is
an example of opening a saved filter within the Visual Tree:

Read the instructions on the next page to learn more about using and modifying object filters.
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Object Filter Manager
Object Filters can be used within the Surveyor/400 Visual Tree to list objects which meet
certain filter criteria. These filters can be opened either under a library or directly under the
Database folder.

To create and modify Object Filters, click the icon on the main Surveyor/400 toolbar. The
Filter Manager screen will be displayed.

Screen Explanation

The Filter Manager screen will show a list of current stored filters. This screen can be scrolled
to the right for viewing more details on the filters. A series of buttons are listed on the bottom
of this screen, which can be used for working with the filters:

Buttons

View Opens the selected filter in view mode.

Add Prompts for values for creating a new filter.

Edit Opens the selected filter in edit mode.

Copy Opens the selected filter. Allows changing the filter and saving it under a
different name.

Delete Deletes the selected filter(s).

Object
Search

Loads the selected filter in the ‘Object Search’ window.
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Close Closes the Object Filter Manager window.

Adding or Editing an Object filter

When choosing to add, edit or copy a filter, a screen will be displayed for specifying the filter
values. Listed below is a description of the values which can be specified:

Basic Filter Details

l Low Detail – Filter can search on the Object Name, Library, Type, Attribute and

Description. Results will show basic details about the objects.

l High Detail – Filter can additionally search on Date, Size and User criteria. This option

is slightly slower than the ‘Low Detail’ option, but also shows more object information.

l All Libraries - Filter will appear under every library within the Surveyor/400 Visual Tree.

l Select Library Below - Filter will only apply to a specific library.
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l All Systems - Filter will appear under every IBM i system in the Surveyor/400 Visual

Tree.

l Select System Below - Filter will only apply to a specific IBM i system.

l Show Under Database Folder – Filter will also show directly under the Database folder

within the Visual Tree. Otherwise, the filter will only appear under the Object Filter

section within a library.

Filter Criteria

Over a dozen different search criteria can be specified through the various tab panels in this
section. Each tab is an additional filter which narrows your search.

Basic Search

Specify an Object name, Library, Type and/or IBM i to search. Object can be a
specific name, *ALL or a generic name (by keying a partial name with an asterisk *
in front and/or behind it). The Library can be a specific name or a library list.

Attribute Search

For finding objects with a certain attribute. For instance, choose the DSPF attribute
to search for Display File objects.

Description Search

For finding objects which have the specified text in the object’s description.

Date Search

For finding objects Created, Modified, Saved, Not Saved, Last Used and Not Used
within a certain time frame or within a duration of days.

Size Search

For finding objects which meet a minimum size, maximum size or are within a size
range.
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User Search

For finding objects created by a particular User id.
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Object Properties
Surveyor/400 allows you to view extensive information (properties) for IBM i libraries and
objects. To view properties, right-click a library or object and choose the ‘Properties’ menu
option. You can also view properties using the Fast Path dialog by keying in the object name
and clicking the ‘Properties’ button.

The property information is segmented into multiple panels which can be selected by clicking
their corresponding tabs at the top of the screen. The tabs displayed will depend on the type of
object selected. For instance, the properties for a database file will have the following tabs:

l General - The General tab displays the basic information about the object.

l Object - The Object tab displays the object details, such as when it was created and

modified. This is similar to the information shown using the OS/400 WRKOBJ

command.
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l Fields - The Fields tab displays the fields (columns) in the file, including their names,

descriptions, types and lengths. By clicking a field, the complete details for the field will

be shown on the bottom half of the screen.

l DBR - The DBR tab displays all the database relations for the selected file. This will

show the dependent logicals along with their key fields and select/omit criteria. You

can right-click any file in this list to choose menu options to work with the file.

l Triggers - The Triggers tab will display all triggers on the file, along with their

conditions and events.

l Constraints - The Constraints tab will display any constraints on the file.

l Authority - The Authority tab will display the authority for both the library and the

object.

l DDS - This tab will display the DDS source code for the file (which is based on the

location stored in the object). If Surveyor/400 cannot locate the DDS for the file, it will

prompt to reverse engineer the file into its DDS source code. This generated source

code can then be saved to a source member.

l Locks - This tab will display any jobs which have a lock on the file. By right-clicking a

job, you can enter text and send a break message to the user(s) or you can optionally

end their jobs.

l Members - This tab displays the members in the file. By clicking a member, the

complete details for the member will be shown on the bottom half of the screen.

l Formats - This tab displays the formats in the file.

l Preview - The Preview tab displays the initial records in the file. The records cannot be

modified. Note: The number of records shown can be adjusted by 1) choosing the

Surveyor/400 Configure screen 2) clicking ‘General Preferences’ and 3) changing the

value for ‘Preview Display Count’.

TIP:

By right-clicking any column heading within a property screen, you can choose menu
options to hide/show columns, search a column, sort a column, print the screen or export
the screen to the Windows clipboard or a PC format.
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Data Areas
Surveyor/400 includes an editor for viewing and modifying Data Areas. To access the Data
Area Editor, right-click a Data Area object and choose the ‘Edit’ option. You can also access the
editor through the Fast Path dialog by keying in the Data Area name and clicking the ‘Edit’
button.

TIP:

A data area can be found using the Object Search screen, which can be opened by clicking
the toolbar icon on the main Surveyor/400 toolbar.

The editor will show the current value of the data area on both the top and bottom halves of
the screen. You can use the bottom half of the screen to specify the new value for the data
area. The ‘Position’ value in the right-bottom corner of the screen will show the position of the
cursor within the data area.
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Listed below is a description of the buttons on the editor screen:

Update/Close Updates the data area with the new value and exits the editor.

Update Updates the data area with the new value and remains in the editor.

Clear Clears the contents of the data area.

Cancel Closes the editor without updating the data area.

Surveyor User Guide www.fortra.com page: 116



/ Command Editor

Command Editor
The Surveyor/400 Command Editor allows authorized users to enter and execute OS/400
commands. The commands can additionally be saved to a command script, which can be
executed at a later time.

Accessing the Command Editor

The Command Editor can be opened by clicking the icon on the main Surveyor/400 toolbar.
It can also be accessed by selecting the ‘Command Editor’ option under the main ‘Tools’ menu.

Entering Commands

OS/400 commands can be entered in the text area at the top of the Command Editor screen. A
command can be prompted by placing the cursor on the command and pressing the F4 key or
the Prompt button.

Multiple commands can be entered for creating a command script. If multiple commands are
entered, a semi-colon must be placed at the end of each command.

Comments can be placed in the script by enclosing the text with a /*  */ (e.g. /* Command
comment */). Blank lines are allowed within the command script.
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EXAMPLE:

/* Delete library XYZ */

DLTLIB LIB(XYZ);

/* Send a message to the user */

SNDMSG MSG(‘Library XYZ deleted’) TOUSR(BOB)

Executing Commands

The command(s) can be executed by clicking the Run toolbar icon. To execute a single
command within a script, highlight the entire command and click the Run button.
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Command Log

The Command Log is located on the bottom half of the screen. Any commands executed
(along with any corresponding messages) will be placed in the log. Up to 100 commands are
stored in the log.

A command can be copied from the log by highlighting the command in the log and pressing
Ctrl+C. Then place the cursor in the command editor and press Ctrl+V to paste the command.

If you want to clear the command log, click the ‘Clear Log’ button.

Saving and Opening Scripts

To save a command script to your workstation, click the toolbar icon. You will be prompted
to specify the directory and name for the script.

To open an existing script file, click the icon and choose the script.

Miscellaneous

The Job Log and Library List can be displayed for the IBM i job which is servicing the
Command Editor. To view this job information, select ‘Job’ from the File menu. 

By default, the library list used in the Command Editor will be the same as the library list
specified in Surveyor/400. If you want to make the Command Editor’s library list different than
that of Surveyor/400, run the CHGLIBL command within the Command Editor.

Authority

If you are a Surveyor/400 administrator, you can disable a User's authority to the Command
Editor by turning off the ‘Command Editor / Custom Commands’ option within the
Surveyor/400 User Access Manager.
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Custom Commands
Surveyor/400 Custom Commands are OS/400 commands which can be selected through right-
click menus for objects, libraries and IFS files. When a custom command is chosen, attributes
from the selected object (such as the name and library) can be used as parameters for the
command.

You can control which OS/400 commands appear on the Surveyor/400 right-click menus using
the ‘Custom Command Manager’. This is similar to defining custom PDM options on the IBM i .

Accessing the Custom Command Manager

The Custom Command Manager can be opened by clicking the icon on the main
Surveyor/400 toolbar. It can also be accessed by selecting the ‘Custom Command Manager’
option under the main ‘Tools’ menu.
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Screen Explanation

The Custom Command Manager screen will show a list of current commands defined. This
screen can be scrolled to the right for viewing more details on the commands. A series of
buttons are listed on the bottom of this screen, which can be used for working with the
commands.

Buttons

View Opens the selected command in view mode.

Add Prompts for values for creating a new custom command.

Edit Opens the selected custom command in edit mode.

Copy Opens the selected custom command. Allows changing the custom command and
saving it under a different name.

Delete Deletes the selected command(s).

Close Closes the Custom Command Manager window.
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Adding or Editing a Custom Command

When choosing to add, edit or copy a Custom Command, a screen will prompt for the
command values. Listed below is a description of the values which can be specified:

Command Information

l Command Name - The descriptive name which will appear on a Surveyor/400 right-click

menu.

l Prompt Button System – IBM i system to be used when prompting the command. The

command must exist on that system.

l Command - The OS/400 command to execute. Substitution variables can be used as

parameters within the command:

&N = Object Name

&L = Library Name

&T = Object Type

&M = Member Name

&B = Member Attribute

l Submit Parameters – When executing a command, you can choose to run it within the

current job or have it submitted to batch. If submitting to batch, you can specify any

special SBMJOB parameters.

l Prompt Before Execution - When this box is checked, the Custom Command will be

prompted before executing. If this box is not checked, the Custom Command will

appear in red on the right-click menu and will execute immediately when selected.
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Menu Selection

l Type of Command - Select the type of IBM i component which the Custom Command is

associated with. The Custom Command can be associate with an IFS file/folder, an

object, a database member or a database file/member.

l Object Attribute - Select the object attribute in which the Custom Command is

associated with. For instance, if you only want the command to work with display files,

then choose the object type of *FILE and the attribute of DSPF.
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l Member Attribute - If the command is associated with a member, you can restrict the

command to only appear when the member has a particular attribute.

NOTE:

Custom Commands are stored in an external file. This file can be shared with other team
members. The name of the file can be modified in the main Surveyor/400 Configure
screen.
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Rational Developer for i (RDi/WDSC)
Integration
Many of Surveyor/400's components can be accessed directly from RDi through a provided
plug-in. From within RDi, users can launch Surveyor/400’s File Editor, SQL editor, Database
Export Wizard, Import Wizard, 5250 emulator, Spooled File Viewer/Converter, and much more.

Pre-requisites:

l Surveyor/400 client must be installed on your workstation

l Surveyor/400 server must be installed on each IBM i .

l RDi 7.x, 8.x, 9.x or WebSphere Development Studio Client for IBM i version 6.x or 7.x.

Installation Instructions RDi 9.5+:

1. Launch RDi.

2. Go to the 'Help' menu and select 'Install New Software...

3. Press the 'Add...' button.

4. Enter 'Surveyor' for the 'Name:'

5. The 'Location:' is www.linomasoftware.com/releases/surveyor/RDi place this URL after

the provided 'http://' text.

6. Expand the Forta or Surveyor Site and check the box next to 'Surveyor/400'.

7. Press 'Next', agree to licensing, press 'Next', press ' Finish'

8. When asked if you would like to restart RDi. Press the 'Yes' button.

9. After re-starting, open the Preferences. Go to the 'Window' menu and select

'Preferences'. Select Surveyor/400. Make sure the 'Install Folder' is correct. It is where

surveyor.exe is located, which is likely C:\Program Files (x86)\HelpSystems

Software\Surveyor or C:\Program Files\HelpSystems Software\Surveyor

10. The plug-in should now be installed. When you right-click IBM i objects in the RSE

perspective you should see a 'Surveyor/400' menu.
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Installation Instructions RDi 7.5, 8.x, 9.x:

1. Launch RDi.

2. Go to the 'Help' menu and select 'Software Updates...'

3. Press the 'Add Site' button. The location is

www.linomasoftware.com/releases/surveyor/RDi place this URL after the provided

'http://' text.

4. Expand the Forta Site and check the box next to 'Surveyor/400'.

5. Press the 'Install...' button

6. Complete the steps in the Install Wizard.

7. When asked if you would like to restart RDi. Press the 'Yes' button.

8. After re-starting, open the Preferences. Go to the 'Window' menu and select

'Preferences'. Select Surveyor/400. Make sure the 'Install Folder' is correct. It is where

surveyor.exe is located, which is likely C:\Program Files (x86)\HelpSystems

Software\Surveyor or C:\Program Files\HelpSystems Software\Surveyor

9. The plug-in should now be installed. When you right-click IBM i objects in the RSE

perspective you should see a 'Surveyor/400' menu.

Installation Instructions WDSC version 6.x and 7.x and RDi 7.0 to 7.4:

1. Launch the Surveyor/400 Application.

2. Go to the ‘Tools’ menu and select the ‘Install WDSc plug-in’ option.

3. Choose which version of WDSc you would like to install the plug-in for.

4. Specify WebSphere Development Studio client’s plug-in install directory. The default

plug-in install directory for WDSC 6.x is: C:\Program

Files\IBM\Rational\SDP\6.0\eclipse\plugins. For WDSC 7.x it is: C:\Program

Files\IBM\SDP70\plugins

5. Press the 'Install' button

6. Restart WDSc (if it is currently running).
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7. Open WebSphere Development Studio Client, open Remote System Explorer

Perspective

8. In Remote Systems Explorer from IBM i System Connection node expand IBM i Objects

node, by right clicking various IBM i objects, a Surveyor/400 menu option with different

sub-menus will be available.

Surveyor/400 components can then be launched from the RDi Remote System Explorer (RSE)
by right-clicking an object and selecting the appropriate Surveyor/400 menu option.

RSE Menu Options

l Edit – For database files, this will open the Surveyor/400 File Editor for viewing and/or

editing records in the database file. For data areas, this will open an editor for viewing

and/or changing the data area value.

l Export – Launches a wizard for downloading database records into a PC-compatible

file or another database file.

l Import – Launches a wizard for uploading PC data into the IBM i database file.

l Generate DDS – Reverse-engineers the physical file into its corresponding DDS source

code.

l Generate SQL – Reverse-engineers the physical file into its corresponding DDL source

code (Create Table statement).

l Properties – Shows properties for the selected object or library, such as creation date,

size, authority, etc.

l Run SQL – Launches the SQL editor for entering and running SQL statements for the

database file.

Surveyor User Guide www.fortra.com page: 127



/ Rational Developer for i (RDi/WDSC) Integration

Adding Surveyor/400 menus and toolbar buttons to the Remote System Explorer Perspective

1. Open the RSE perspective.

2. From "Windows" menu, select the "Customize Perspective " item

3. Select the "Commands" tab

4. Select (check) the “Surveyor/400 Features” option

Launching Surveyor/400 components from the RDi toolbar

The following Surveyor/400 components can be accessed from the main WDSC toolbar:
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l Surveyor Application – For launching the entire Surveyor/400 application.

l Fast Path – If you know the name of the object to work with, the Fast Path dialog will

allow you to key in the object name and click the Surveyor/400 operation to perform.

l SQL Editor - For entering, running and testing SQL statements.

l Spooled File Manager - For viewing and downloading spooled files into PDF or Text

documents.

l TN5250 – For launching a Telnet 5250 session.
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Journals
Surveyor/400 allows users to view journal
entries for database files
that are journaled and also provides a DSPJRN
wizard for *JRN objects. To view journal
entries for a database file, right-click on a
database file and select ‘Journal Entries’. A
Retrieve Journal Entries screen appears which
allows filtering of journal entries. Database
type entries, such as insert, update and delete
are retrieved.

The results are placed in a temporary file and
opened in the File Editor. The temporary file
consists of journal entry information as well as
the database fields from the file mapped to
values from the journal entry.

Once open in the File Editor, it may be saved as
a Journal Layout in which the 'Retrieve Journal
Entries' filter criteria is saved. When opening
the layout, the user is prompted for 'Retrieve
Journal Entries' filter criteria. A new temporary
file is created containing current journal
entries.
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To view journal entries for a journal (*JRN object), right-click on a journal object and select
‘Display Entries’.

Entries are placed in the file specified on step one. The DSPJRN command on step two will be
executed. The results will be displayed in the selected viewer on step three.
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Advanced Transfers and
Automation
Transferring Objects Between IBM i
The Surveyor/400 FTP Wizard allows you to transfer one or more objects and libraries to other
IBM i machines and LPARs. This feature requires a FTP server to be running on the target IBM i
system/LPAR.

The FTP Wizard can be opened using one of the following methods:

l Highlight one or more objects/libraries (from the Visual tree or Search screen), then

right-click and choose ‘FTP’. Select the ‘FTP to IBM i ’ sub-option.

l Open the Fast Path dialog, key in an object name and library, then click the ‘FTP’

button. Select the ‘FTP to IBM i ’ sub-option.
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Follow the steps below to use the FTP Wizard:

1. Select the target IBM i system from the drop-down box.

2. Indicate if a save file should be used to package the object(s) before transfer. In most

cases, a save file should be used in order to retain the object characteristics. The main

exception is when sending a physical file member to another physical file member on

the target machine.

3. Click the ‘Next’ button to specify additional FTP options (read step 4 if using a save

file):

4. Save File screen options:

l By default, the save file name will be automatically created on the target system

with the *AUTOGEN option. Otherwise you can specify a different save file name.

l Indicate the OS/400 release of the target IBM i .

l Specify if the object(s) should be restored from the save file on the target IBM i . If

so, specify the restore library (if different than the saved library).

5. Click the ‘Send’ button to run the FTP transfer immediately. After the transfer is

completed, a window will display the FTP log and indicate if any errors were found.
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6. Otherwise to run the FTP transfer within a submitted job, click the ‘Send Batch” button.

TIP:

FTP transfers can be run from the IBM i system using the SURVEYOR/FTPOBJ command.
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Transferring Objects between Workstation
and IBM i
Surveyor/400 can be used to transfer Save Files between the IBM i and workstation. Objects
and libraries can also be transferred to the workstation. These features require the FTP server
to be running on the IBM i .

Transferring a single save file to the workstation.

1. Highlight the Save file (from the Visual tree or Search screen), then right-click and

choose ‘FTP’. Otherwise you can open the Fast Path dialog, key in the Save file name

and then click the ‘FTP’ button.

2. Select the ‘FTP to Workstation’ sub-option.

3. Choose a destination file on the workstation and click the ‘Execute’ button. The Save

file will then be transferred to your workstation.

Transferring multiple save files to the workstation.

1. Highlight the Save files (from the Visual tree or Search screen), then right-click and

choose ‘FTP’.
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2. Select the ‘FTP to Workstation’ sub-option.

3. Choose a destination directory on the workstation and click the ‘Execute’ button.

Transferring objects/libraries to the workstation.

Surveyor/400 can download selected objects or libraries to the workstation via a Save file.

1. Highlight the objects or libraries (from the Visual tree or Search screen) to transfer,

then right-click and choose ‘FTP’. Select the ‘FTP to Workstation’ sub-option.

2. The command for saving the objects will appear in the top half of the screen. Click the

‘Prompt’ button if you want to override any parameters on the command.

3. Choose a destination file on the workstation.

4. Click the ‘Execute’ button to run the transfer.

5. If you did not change the default Save file name within the ‘Save command’, then that

save file will be removed when the transfer completes.

Transferring Save Files from a Workstation

A Save file can be transferred from the workstation to the IBM i using Surveyor/400.

1. The target save file must already exist on the IBM i . If not, then create an empty Save

File by right-clicking a library and select ’Custom Commands -> Create Save File’.
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2. Highlight the target Save file (from the Visual tree or Search screen), then right-click
and choose ‘FTP’. Otherwise you can open the Fast Path dialog, key in the target Save

file name and then click the ‘FTP’ button.

3. Select the ‘FTP from Workstation’ sub-option.

4. Select the source Save file on the workstation and click the ‘Execute’ button.

Surveyor User Guide www.fortra.com page: 137



/ Specifications

Specifications
A specification defines details about the transfer, such as source and destination, and the
format of the transfer. A specification may be saved in either XML format or Serialized format.
. Specifications can be used on a workstation or by Surveyor/400 IBM i commands.

XML

l XML specifications are new in version 4.0.

l XML specifications can be viewed or changed using a text editor.

l If using EXPDTA, IMPDTA or EXPSPL Java 1.6 is required on the IBM i . (The Java

requirement is met on the workstation because Surveyor is installed with Java 1.7.)

Serialized

Serialized is a Java proprietary format and cannot be as easily viewed or changed with a text
editor.
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Native IBM i Commands for Transfers
Using the supplied Surveyor/400 native OS/400 commands, you can initiate Transfers from an
IBM i machine. These commands can be entered on an IBM i command line, placed in CL
programs and used in job schedulers on the IBM i .

Native transfer commands provided with Surveyor/400:

l EXPDTA – Exports DB2/400 database records into a PC formatted text file s (i.e. Excel,

XML, delimited, HTML) or another DB2/400 database file.

l IMPDTA – Imports PC files into DB2/400 database files

l EXPSPL – Exports Spooled Files into PDF or text files

l FTPOBJ – Transfers objects (via FTP) or libraries between IBM i machines (or LPARs)

l FTPF – Transfers database members (via FTP) between IBM i machines (or LPARs)

The Surveyor/400 transfer commands can be found in the SURVEYOR library. The commands
are also organized on a menu which can be launched by entering GO SURVEYOR/MENU.

Tip: Complete on-line help text is available for all the Surveyor/400 native IBM i commands. To
view this help text, prompt the command (with F4) and then press F1 on any command
parameter.

Using a Surveyor/400 Transfer command

Perform the following steps to use any of the Surveyor/400 commands provided:

1. Key in the qualified command name (i.e. SURVEYOR/EXPDTA).

2. Press F4 to prompt the command.

3. Press F1 on any parameter for on-line help.

4. Press F10 to specify additional parameters on the command.

5. Press Enter after specifying the parameters.
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Example

Listed below is an example of converting Nebraska customer database records into an Excel
document using the Surveyor/400 EXPDTA command:

Surveyor Export Database File (EXPDTA)

Type choices, press Enter.

Use Query? . . . . . . . . . . . *YES   *YES, *NO              

Query  . . . . . . . . . . . . . >; select name, address, city, state

fro customers where state = 'Nebraska'                                                    

File format  . . . . . . . . . . >; *EXCEL    *DELIMITED, *FIXED,

*HTML...

Column headings in first row?  . >; *YES         *YES, *NO

IFS Destination  . . . . . . . . >; /ExcelFiles/NebraskaCustomers.xls  

F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this

display    F24=More keys                  
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Automating Transfers on the IBM i
To schedule a transfer, you can place the Surveyor/400 transfer command in a job scheduler
on the IBM i . As an example, the following instructions outline how to schedule an Export
transfer using IBM’s job scheduler.

1. Enter the OS/400 command of WRKJOBSCDE

2. Press F6 to add a new entry.

3. Key in the Schedule Entry values and Press Enter.

Add Job Schedule Entry (ADDJOBSCDE)                     

Type choices, press Enter.

Job name . . . . . . . . .&gt; BUILDEXCEL      Name, *JOBD                  

Command to run . . . . . .&gt; SURVEYOR/EXPDTA USEQRY(*YES) QRY

('select name, address, city, state from customers where state =

''NE''')

TYPEOFEXP(*EXCEL) HEADING(*YES) IFSDES

('/ExcelFiles/NebraskaCustomers.xls')                                                 

Frequency  . . . . . . . .*DAILY  *ONCE, *WEEKLY, *MONTHLY     

Schedule date, or  . . . .*CURRENT Date, *CURRENT, *MONTHSTR...

Schedule day . . . . . . .*NONE  *NONE, *ALL, *MON, *TUE...

+ for more values                                              

Schedule time  . . . . . .23:00:00    Time, *CURRENT               

 Bottom

F3=Exit   F4=Prompt   F5=Refresh   F10=Additional parameters  

F12=Cancel   F13=How to use this display    F24=More keys   
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Field Descriptions:

Job Name Unique name of the job

Command to run Enter the Surveyor/400 command to run

Frequency How often the job is submitted to run

Schedule date Date to run the job

Schedule day Day of the week to run the job

Schedule time Time to run the job
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Automating Transfers on Workstations
You can run transfers from your workstation without launching the main Surveyor/400
application. These transfers can be launched from the desktop, executed within a custom
program or automated from a scheduler. Follow the steps below to set up a transfer:

1. Create a Transfer Specification within Surveyor/400, which contains the details about

the file transfer (such as the source file name, format and destination file name). Read

pages "Export Wizard" on page 62 through "Configuring an SSL Connection" on page 80

to learn how to build Specifications using the Surveyor/400 Export and Import Wizards.

2. Locate the Surveyor/400 application launcher, which is located in the Surveyor

installation directory. Within Windows, the launcher name is “surveyor.exe” and is

located in the directory of “C:\Program Files\HelpSystems Software\Surveyor” by

default.

3. Choose the appropriate Surveyor Command Line option to run the Transfer

Specification.

Command Line Options for Surveyor application launcher

surveyor.exe -CommandOption <specification file>

CommandOption Description Required
Parameters

Optional
Parameters

-exportdb Runs a database export without
prompting. Useful for scheduling
unattended exports or embedding in
other programs.

Specification
file created in
Export Wizard

Log file
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-exportdb2 Same as -exportdb, but allows
overrides.

Specification
file created in
Export Wizard

Log file

Override
Source

Override
Destination

Error
Message File

-exportdbprompt Opens the specification within the
Export Wizard without opening the
main Surveyor/400 application.

Specification
file created in
Export Wizard

Log file

-importdb Runs a database import without
prompting. Useful for scheduling
unattended imports or embedding in
other programs.

Specification
file created in
the
Import Wizard

Log file

-importdb2 Same as -importdb, but allows
overrides.

Specification
file created in
the
Import Wizard

Log file

Override
Source

Override
Destination

Error
Message File

-importdbprompt Opens the specification within the
Import Wizard without opening the
main Surveyor/400 application.

Specification
file created in
the
Import Wizard

Log file
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-exportspool Runs a spooled file export without
prompting. Useful for scheduling
unattended exports or embedding in
other programs.

Specification
file created in
the
Export
Spooled File
Wizard

Log file

-exportspool2 Same as -exportspool, but allows
error file

Specification
file created in
the
Export
Spooled File
Wizard

Log file

Error
Message File

-exportspoolprompt Opens the specification within the
Export Spooled File Wizard without
opening the main Surveyor/400
application.

Specification
file created in
the
Export
Spooled File
Wizard

TIP:

You may already have a shortcut on your desktop for Surveyor/400. If so, make a copy of it
and append any command line options to it. Example:
"C:\Program Files\HelpSystems Software\Surveyor\Surveyor.exe" -exportdb
exportcustomers.exp

Log Files

A log file contains details and about file transfers, as well as any error messages that may
occur. Every time a log file is used, its contents will be erased unless the option +appendlog is
used. The +appendlog causes new log information to be appended to the end of the file. If no
log file is specified, then the Surveyor/400's default error log file is used.

The command syntax is listed below. Optional parameters are enclosed in brackets [optional].
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surveyor.exe -CommandOption <specification file> [ <log file> [+appendlog] ]

surveyor.exe -exportdb2 <export specification file> [ --overridesource <overrideSourceFile>] [ --
overridedest<overrideDestFile>] [ --logFile <log file> [+appendlog] ] [--errorMessageFile
<messageFile>]

Examples

Example 1:

The example below launches the Export Wizard for the demo.exp specification.

Surveyor.exe -exportdbprompt C:\Exports\demo.exp

Since no log file is specified, then all errors and output will be stored in C:\Program
Files\HelpSystems Software\Surveyor\error.log.

Example 2:

The below example would run the export defined in the demo.exp file. The details of the
transfer as well as any error messages will be placed in C:\SurveyorExports\demoError.log.
Due to the +appendlog option the results of every subsequent transfer will be appended to the
end of the log file. Both the source and destination are overridden.

"C:\Program Files\HelpSystems Software\Surveyor\Surveyor.exe" -exportdb2
C:\SurveyorExports\demo.exp --overridesource SURVEYOR.DEMO --overridedest
C:\SurveyorExports\demoOver.txt --logfile C:\SurveyorExports\demoError.log +appendlog

Example 3:

The example below runs an import (without prompting) and appends to the log file of
\Imports\demoError.log.

Surveyor.exe -importdb C:\Imports\demo.imp C:\Imports\demoError.log +appendlog
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Example 4:

The below example would run the import defined in the demo.imp file. The details of the
transfer as well as any error messages will be placed in C:\SurveyorImports\demoError.log.
Due to the +appendlog option the results of every subsequent transfer will be appended to the
end of the log file. Both the source and destination are overridden.

"C:\Program Files\HelpSystems Software\Surveyor\Surveyor.exe"  -importdb2
C:\SurveyorImports\demo.imp --overridesource C:\SurveyorImports\demoOver.txt --overridedest 
SURVEYOR.DEMO --logfile C:\SurveyorImports\demoError.log +appendlog

NOTE:

A file name which contains spaces must be surrounded in double quotes. Example:
"C:\SurveyorExports\my test file.exp"

Error Message File

If the error message file is specified, certain messages, such as ‘no records exported’ can be
monitored for.

Questions and Answers

Q: How do I open a Surveyor/400 Specification from the desktop by clicking it?

A: A Specification will be opened within the appropriate Surveyor/400 Wizard if it is clicked on,
providing that File Associations have been set up. File associations are created when
Surveyor/400 is installed using version 2909 or higher.

If Surveyor/400 was originally installed at a version lower than 2909, then you can create the
file associations using the -addregfa command option. Example:
"C:\Program Files\HelpSystems Software\Surveyor\Surveyor.exe" -addregfa

Q: How do I schedule an unattended transfer?
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A: You must use a scheduling program. If you are using Windows, go to Control Panel ->
Scheduled Tasks. Select the Surveyor.exe from the list of applications. Make sure to choose
Surveyor.exe and not Surveyor.ico.

NOTE:

When creating a Windows scheduled task, you may have to create the task first and add
the command line options afterward by right-clicking the newly created task and selecting
Properties. Add the command line option to the Run field.

When using the -exportdb, -importdb, or -exportspool options to run unattended transfers, the
system that is saved with the specification must contain a user name and password. To do
this, you must specify the user name and password when you define the system connection in
Surveyor/400.

Integrated File System (IFS)

The Integrated File System (IFS) is the area of the IBM i where stream files can be stored, such
as pictures, text files, PDFs, Excel documents, etc. Using Surveyor/400, you can easily explore
and manage files and folders located within the IFS.
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The IFS can be explored by either double clicking the ‘IFS’ folder in the Surveyor/400 tree, or
opening the IFS Explorer by right-clicking on the IBM i , or any IFS folder. A list of IFS files and
folders will be displayed. A folder can be opened by double-clicking it.

The IFS Explorer allows you to type in a name of any IFS in the location bar.  You can also filter
a list of IFS files or navigate by using the ‘back’ and ‘forward’ buttons.

Available menu actions are found by right-clicking a file or folder. Listed below is description of
the available actions.

Files and folders may be multi-selected by left-click while holding down the shift or control key.

l Copy or Move IFS files and folders to the Workstation (PC)

l Copy Workstation files and folders to the IFS.

l Cut/Copy IFS files and folders to another IFS folder.

l Cut/Copy IFS files and folders to another IFS folder on a different IBM i .

l Delete

l Rename

l Open as Text.

l Open by double-clicking if the file is capable of being opened by Surveyor. Images, text

files, and Surveyor specification may be opened.

l Custom Commands. You can define your own IBM i commands to work with an IFS file.

l Edit Authority. Change IFS file permissions.

l Copy Name. Copies the full path name.

l Properties. View IFS file properties

l Sharing. Create, display, change or remove an IFS file share. Right-click on folder

l Shares. Displays all shares. Right-clicking on the main IFS folder in the tree.
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Surveyor/400 Configuration
Library Lists
Each user is assigned their own library list within Surveyor/400, which contains one or more
IBM i libraries. Since there is often a great number of libraries on an IBM i system, a library list
allows a user to just focus on those libraries which they work with on a day-to-day basis.

A library list has several uses within Surveyor/400: 

l When a user expands the database folder within the visual tree, only those libraries in

their library list will be shown.

l When a user is prompted for an IBM i object name (such as within the Fast Path, File

Search or SQL Editor);  if the user enters just the object name without qualifying it with

the library name, then the library list will be searched for that object name.

l For security purposes, a Surveyor/400 administrator can restrict a user to only be able

to work with objects in a library list that was assigned to them.

By default, the user’s Surveyor/400 library list is based on the library list assigned to their user
profile’s job description on the IBM i . A user’s library list can be customized by a Surveyor/400
administrator or can be customized by the user themselves (if they have authority to do so).

If you want to modify your own Surveyor/400 library list:

1. Right-click the IBM i in the tree.

2. Select the ‘Library List’ menu option.

3. The Library List Setup screen will be displayed.

If you are a Surveyor/400 administrator and want to modify the library list for another user:

1. Right-click the IBM i in the tree.

2. Select the ‘User Access’ menu option.
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3. Highlight the user in the list and click the ‘Edit’ button at the bottom of the screen.

4. Click the ‘Modify Library List’ button from the ‘General’ tab.

5. The Library List Setup screen will be displayed.

TIP:

If you do not want the user to be able to modify their library list, uncheck ‘Modify Library
List’ on the ‘General’ tab of the user screen.

The Library List Setup screen is divided into two panes. The left pane is used to select libraries
for adding to the library list. The right pane shows the current library list for the user.

Library List Types

There are four different types of Library Lists that can be chosen from the library list screen.

*LIBL By default, this is the library list assigned to the user’s job description on the
IBM i .

*USRLIBL Same as *LIBL, but does not include the system portion of the library list.

*ALL All libraries on the system.
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*ALLUSR Same as *ALL, but does not include IBM system libraries.

Adding a Library to the List

The library list can be customized by first setting the Library List Type to either *USRLIBL or
*LIBL. A library can then be added to the library list by performing one of the following options:

l Choose the ‘Add Library’ radio button, key in the name of the library and press Enter OR

l Choose the ‘List Libraries’ radio button. A list of available libraries will be displayed.

Double click the library to add to the library list.

Adjusting the Sequence of the Library List

Libraries will always be added to the end of the library list. To move a library into a different
position within the library list, drag the library’s corresponding drag-button up or down with the
mouse.

Removing a Library from the List

A library can be removed from the library list by double clicking the library in the right pane.

NOTE:

Any changes made to the Surveyor/400 library list will not affect the normal OS/400 library
list for the user.

Group Library Lists

A list of libraries may be organized into groups. These Library List Groups can be used as a
user's library list.

Library Lists Group Manager

This feature allows you to create and maintain groups of libraries. Authorities can be specified,
to control who can access and modify the Library List Group. The 'Find Users' tool identified
which users are using a selected group. The 'Find Group' tool finds which group is using a
given library.
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Workstation Configuration
Each workstation (PC) can be configured with Surveyor/400 connection information and
preferences. This configuration information is stored in the Surveyor/400 installation directory
for the workstation. To view and/or change the workstation configuration, click the pocketknife
icon or select the ‘Main’ menu option and choose ‘Configure’. The Configure screen will be
displayed.

IBM i Connection Information

The list of IBM i system connections will be displayed at the top of the Configure screen. A
system can represent an IBM i machine, LPAR partition or IASP. Use the buttons (described
below) to configure the IBM i system connection information.

l Add button – You will be prompted for information to define a new IBM i system

connection.
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l Edit button – You will be prompted to change the connection information for the

selected system.

l Delete button – Removes the selected connection from the list.

l Copy button – Copies the selected connection details to save time creating a new

connection.

l Apply Key – Prompts you to enter a Forta license key for the selected system.

l Uninstall – Administrators can use the Uninstall button to delete the Surveyor/400

licensed program from the selected IBM i system.

NOTE:

Changes made in the Configure screen will not be stored unless you press the 'OK' button
at the bottom of the configure screen.

Preferences

There are several different sets of preferences which can be viewed and modified. To change
to a different set of preferences, highlight its name on the left side of the Configure screen.

General Preferences

l Tree Tooltips - Check this box to display the library’s description (within a pop-up) when

positioning the mouse over the library name in the tree.

l Confirm Before Exit – Check this box to show a confirmation dialog when exiting the

Surveyor/400 application.

l Remember Table Changes – Most Surveyor/400 screens can be customized. For

instance, screen table columns can be hidden, resized, moved and resorted. Check this

box to have Surveyor/400 remember the screen customizations. Note: Screen

customizations within the File Editor can be saved as File Layouts.

l Prompt for Report Headings – When enabled, the you will be able to specify a custom

report title when printing information through Surveyor/400.

l Export Completion Message – Whenever records are exported with Surveyor/400, this

option will display a dialog indicating how many records were exported.
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l Show Fast Path at Startup – Shows the Fast Path screen whenever Surveyor/400 is

started. The Fast Path screen allows you to specify an object name to quickly work with

in Surveyor/400.

l Remember Window Sizes  – This option remembers the window size of various

features when the window is closed. When the feature is reopened, the window will be

the same size it was when last closed. If the feature has a split pane, the divider

location is also remembered.

l Custom Command File – Specify the location of the file which contains any custom

OS/400 commands created or modified by the user.

l Check for Updates on IFS - Specify how often to check for new versions of

Surveyor/400 on the IBM i IFS. This update check can take a few seconds each time

Surveyor/400 connects. To get the fastest possible connection time, you may not want

to check for updates daily.

l Look and Feel - Surveyor/400's GUI interface can provide a different Look and Feel (i.e.

fonts, colors) based on your preference. The four options available are Metal,

CDE/Motif, Windows and 5250. After specifying a different Look and Feel, you will have

to restart Surveyor/400 in order for it to take effect.

l Preference Location - Denotes where on the workstation the preferences are stored.

l Install Folder - Preferences are stored in the same folder in which Surveyor/400 is

installed. All users on the workstation will share preferences.

l User Folder - Preferences are stored in a folder specific to the user signed on.

Each user will have their own preferences.

Network Preferences

Web Update Proxy Server - If you have a Proxy Server on your network, you will need to enter
the Proxy information in order to perform a Web Update within Surveyor/400. If you're using
Microsoft Internet Explorer, the Host and Port information can be found by going to Tools -->
Internet Options --> Connections tab --> LAN Settings.
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l Proxy Host - IP Address or domain name for the Proxy Server.

l Proxy Port - IP port for the proxy server.

l Proxy User - User ID for proxy server.

l Proxy Password - Password for proxy server.

l Socks Server - Name given to the Socks Server.

l Socks Host - IP Address or domain name for the Socks Server.

l Socks Port - IP port for the Socks Server.

System Preferences

l IBM i Terminology - Displays IBM i naming conventions (Physicals, Logicals and Fields)

for database objects.

l SQL Terminology - Displays SQL naming conventions (Tables, Indexes, Columns) for

database objects. Long table and column names will appear in the tree, File Search, and

property screens.

l Detailed File Information - Displays additional information (i.e. size, creation date)

about files within the Tree view.

l Show DDM Folders in Tree - Displays folders for DDM files in the visual tree.

l Show DDM Remote File Locations (Slower) - For DDM files, will additionally display the

location of the remote files.

l Object Search Detailed Information (Slower) – Displays additional information about

objects in the Search screens.

l Display File Sizes – Specify if the size of objects should be displayed in Kilobytes (KB),

Megabytes (MB), Gigabytes (GB) or Bytes.

l Preview Display Count - Specify how many records to display in the File Properties

Preview screen.

Security Preferences

l Certificate Manager – Manage SSL Certificates.
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Export Preferences

l Export Directory - Default workstation directory location for exporting files.

l File Format - Default file format (Delimited, Fixed Width, HTML, XML, Excel, or

Database) when exporting within the Export Wizard.

l Date Format - Default format for date fields when exporting within the Export Wizard.

When left blank, the format will be yyyy-mm-dd.

l Date Delimiter - Default delimiter for date fields when exporting within Export Wizard.

Delimiter is ignored if date format is blank.

l Decimal Symbol – Default character used as a decimal point.

l NULL Substitute – Default substitute value for NULL capable fields.

l End of Record – Default control characters for delimiting exported records (for

delimited or fixed-width).

l Number of Records to Export – Maximum number of records to export at a time. A

blank value will export all.

l Initial File Name Format - The Export Wizard will determine the initial output file name

based on this setting. For example, when exporting a delimited file, if the library name is

SURVEYOR and the file name is DEMO and the format selected is 'Library_File', the

initial file name would be SURVEYOR_DEMO.txt. If 'Member' is chosen and the member

name is *FIRST the file name will be used.

l Initial File Name Use File Editor Layout Name - If a File Editor Layout is being exported,

the initial output file name will be the Layout name.

Fast Path Preferences

Select Function for Enter Key - Specify which function to perform when pressing the enter key
within the Fast Path dialog.

File Editor Preferences

l Default Row Mode
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Single Row - When the file editor is opened, it will default to viewing one record at a
time.

Multiple Row - When the file editor is opened, it will default to viewing multiple rows
at one time.

l Default Field Naming

Field Name - The column heading for each field will be the field name.

Field Description - The column heading for each field will be the field description.

l Default Edit Mode

View – File editor will default to View Mode when opened. No changes can be made
in View Mode.

Edit – File editor will default to Edit Mode when opened. Changes to database
records are allowed in Edit Mode, as long as the Surveyor/400 administrator has
granted those rights.

Add – File editor will default to Add Mode when opened. New database records can
be added in Add Mode, as long as the Surveyor/400 administrator has granted
those rights.

l Page Size – Specify the number of records to display on each page within the File

Editor.

l Show Popup Field Descriptions – When the mouse is placed on top of a field column

heading within the File Editor, a popup window will show additional information for the

field (i.e. field name, type, length, description and long name).

l Show tab and new line characters - New line and tab characters are represented as \n

and \t respectively. New line and tab characters can be entered by typing \n and \t, or

by pressing the Enter or Tab keys when using the Field Editor. Uncheck this box if you

do not want \n and \t character to be represented as new line and tab characters

l Alternate Row Color - Changes the background color of every other row.
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l Filter Fields - Show fields as seen in Layout: On the Filter screen when selecting a field,

the fields will be displayed in the layout order and hidden layout fields will be also be

hidden.

IFS Editor Preferences

l Editor buffer (page size) – Specify the maximum page size when editing an IFS file.

l Tab Size – Specify how far the cursor goes over when the tab key is pressed on the

keyboard.

l Background Color – Specify the background color of the IFS text file editor.

l Text Color – Specify the text color within the IFS text file editor.

l Text Size – Specify the font size within the IFS text file editor.

l Text Style – Specify the font style within the IFS text file editor.

IFS Explorer Preferences

l Text Style – Specify the font style within the IFS text file editor.

l Root – IFS root folder.

l None – Does not load initial folder.

l Folder – Specify a folder name.

l Display Shares

Import Preferences

l Import Directory - Default workstation directory location.

l File Format - Default file format (Delimited, Fixed Width, Excel or Flat).

l Date Format - Default format for date fields.

l Decimal Symbol – Default decimal point character.

l Suppress Warnings - Suppresses import warning messages such as 'Data truncation'

and 'Value replaced with 0'.
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l Substitute NULL For String - Indicates that null-capable fields will be set to NULL based

on the value entered below.

l String to Substitute NULL For – Specify the string value which indicates a Null value in

the source file.

Spooled File Viewer Preferences

l Always show Loaded Pages Toolbar - Displays the “Loaded Pages” Toolbar menu

option within the Spooled File Viewer.

l Always use Filter Overprinting – Suppresses overprinting lines from being displayed in

the Spooled File Viewer.

NOTE:

Overprinting is often used to highlight text, but can cause formatting issues in the viewer.

Spooled File Exporter Preferences

l Export Spooled File Directory – Default directory location to stored exported spooled

files.

l Always use Filter Overprinting - When checked, spooled files will be exported without

overprinting.

l Export by bytes (faster) - When checked, the export progression and completion

message will be displayed in bytes.

l Export by pages (slower) - When checked, the export progression and completion

message will be displayed in pages.

l Export Text Options – Specify options specific to text format exports.

l Export PDF Options – Specify options specific to PDF format exports.

SQL Editor Preferences

GENERAL TAB

l Default Scripts Directory –Default directory location when saving or opening SQL

scripts.
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l Script contains SPL - Check this box if SQL script contains Stored Procedure Language

statements that contain Begin and End keywords.

l Stop on Error - When running a script with multiple statements, execution will stop if an

error is encountered.

l Clear Log on Execute - Clears the SQL Log when a script is executed.

l Use Syntax Coloring - SQL keywords, comments and literals appear as different colors.

l Font – Set font.

l Tab Size - Size of tab.

l Convert Tabs to Spaces - Instead of a tab character, spaces will be inserted when the

tab key is pressed. The number of spaces is determined by the 'Tab Size' preference.

RESULTS TAB

l Page Size – Specify how many records to display per page within the SQL result sets

window.

l Result Headings - The results window column headings can show either column names

or column labels.

l Show Popup Field Descriptions - When mouse hovers over the result heading a popup

window box appears that contains the Field Name, Type, Precision and Description.

l Clob Characters - Specifies the number of characters of a clob field that will be

displayed. For example specifying 100 will display the first 100 characters of the field.

CONNECTION TAB

l SQL Naming – Specifies that a period should be used to separate the library and file

name

(i.e. OELIB.CUSTMAST).

l System Naming – Specifies that a slash should be used to separate the library and file

name

(i.e. OELIB/CUSTMAST).

l Library List – Default library list to use when a SQL statement is specified without a

qualified table name. The libraries should be separated with commas.
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l Translate CCSID 65535 - Specifies whether translation of ASCII data stored in columns

on the system with an explicit CCSID of 65535 is disabled or enabled.

l Decimal Separator – Specifies the decimal separator character.

l Date Format - Specifies the date format in date literals within SQL statements. Useful

when using the SQL Date function.

l Date Separator - Specifies the date separator in date literals within SQL statements.

Useful when using the SQL Date function.

l Time Format - Specifies the time format and separators used in time literals within SQL

statements. Useful when using the SQL Time function.

l Time Separator - Specifies the time separator used in time literals within SQL

statements. Useful when using the SQL Time function.

Stored Procedure Preferences

l Connection - Default refers to the main Surveyor connection, while Custom will open a

new connection with user defined properties. The connection is used during execution

or creation of stored procedures.

l Connection Properties - See SQL Editor Preferences – Connection Tab – for

descriptions.
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User Security
A user must specify a valid IBM i user id and password within Surveyor/400 to connect to an
IBM i system. Surveyor/400 will honor any existing OS/400 user authorities specified for the
objects and libraries on the system. In other words, if a user is not authorized to an object on
the system, then they will not be able to access this object through Surveyor/400.

In addition to normal OS/400 user security and object authorities, Surveyor/400 provides an
additional layer of security called “User Access”. This User Access feature allows designated
Surveyor/400 administrators to control which Surveyor/400 features and IBM i libraries each
user has access to.

Each IBM i machine (or LPAR) is configured with its own User Access settings. For instance, a
Surveyor/400 user could be granted User Access rights to modify database records on a
Development IBM i , but can be restricted from modifying database records on a Production
IBM i .

NOTE:

Surveyor/400 User Access settings are stored within a secure database in the SURVEYOR
library for each IBM i system or LPAR.

A Surveyor/400 user can either be configured with its own authority or the user can adopt its
authority from a User Group.

The Surveyor/400 User Access feature can be accessed by right-clicking an IBM i system
within the Visual Tree, then selecting the ‘User Access’ option.
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Screen Explanation

The User Access screen will show a list of currently configured Surveyor/400 Users and
Groups, along with their authorities for the selected IBM i system. This screen can be scrolled
to the right for viewing more details on the user authorities. A series of buttons are listed on
the bottom of this screen, which can be used for working with the Users and Groups:

Buttons:

View Opens the selected user in view mode.

Add Prompts for values for creating a new user or group. This feature is only available
to Surveyor/400 administrators.

Edit Opens the selected user or group in edit mode. This feature is only available to
Surveyor/400 administrators.

Delete Deletes the selected user(s) or group(s). This feature is only available to
Surveyor/400 administrators.

Copy Creates a new user by copying an existing user or group settings.

Refresh Reloads the current list of users and groups.

Close Closes the User list window.
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Adding/Editing a User or Group
After selecting the ‘Add’ or ‘Edit’ button from the User List screen, a dialog will prompt for the
values for the User or Group.

The top half of the User screen is for specifying general information for the User or Group. The
bottom half of the screen is where the authorities can be specified for the User or Group.
Authorities can be turned on or off by clicking the check boxes within the various tab panels.

After completing the information, click the ‘OK’ button to create the User or Group.

Listed below is a description of the fields within the user dialog.

User Access - User Information

From the top half of the screen, indicate if you are creating a User or Group. Then specify the
field values for the Group, IBM i User ID and Description.
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Fields when adding a Group:

Group Specify the name of the new Group.

IBM i User ID Leave blank.

Description Description of the Group.

Fields when adding a User:

Group If the user will adopt its authorities from a group, then select the Group from
the drop-down list.

IBM i User ID Must correspond with an existing user profile on the IBM i .

Description Description for the user.

NOTE:

A user id of *NEWUSR is supplied with Surveyor/400. If a new user connects to a system
and if that user has not yet been configured in Surveyor/400, then that user will
automatically adopt the authorities of the *NEWUSR user id. You should therefore set the
authorities for *NEWUSR to the minimum rights you want new users to have.

User Access - General tab

Listed below is a screen-shot of the General tab on the User Access screen:
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Field descriptions:

Surveyor/400
Access

If this box is unchecked, then the user will not be able to use any
Surveyor/400 features.

Object Access If this box is unchecked, then the user will not be able to work with any IBM i
objects or libraries using Surveyor/400. The exception is that the user can
work with records in a database file by opening a File Layout in which they
have authority to (if they have rights to the File Editor).

Administrator
Rights

Indicates if the user has administrator rights within Surveyor/400. An
administrator will have access to all Surveyor/400 features, including the
ability to create/modify users within Surveyor/400.

Command
Editor / Custom
Commands

Indicates if the user can run non-interactive OS/400 commands from within
Surveyor/400. If this box is unchecked, the user also will not be able to
delete non-database objects.

Modify Library
List

Indicates if the user can modify their library list. If this box is unchecked,
then the user can only access data and objects within the libraries which
have been assigned to them by the administrator.

View User
Access

Indicates if the user can view user settings with the User Access feature.

Click the button labeled ‘Modify Library List’ to set the library list for the user. If the user does
not have rights to modify their library list, then the user will only be able to access data and
objects within the libraries assigned to them.

NOTE:

The user that installed the Surveyor/400 licensed program on the IBM i will be considered
an administrator. This user can grant administrator rights to additional users as needed.

User Access - File Editor tab

Listed below is a screen-shot of the File Editor tab on the User Access screen. This tab allows
you to specify the types of authority a user has to the Surveyor/400 File Editor:
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Field descriptions:

File Editor
Access

Choose from these options:

l Edit - allows the user to edit records in database files. If enabled, then

indicate if the user can Add, Change, and Delete records. View - limits

the user to only view records in database files.

l No – user cannot use the File Editor.

Public
Layout
Authority

Indicates if the user can utilize File Editor Layouts which have public authority.

Mass
Delete

Indicates if the user can perform mass deletes of records within the File Editor.

Mass
Update

Indicates if the user can perform mass updates of records within the File Editor.

Add Allows the user to add records to database files.

Change Allows the user to change records in database files.

Delete Allows the user to delete records in database files.
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NOTE:

A File Editor Layout can further restrict the user’s authority to a file. For instance, you could
create a Layout that restricts the user to ‘View-only’ rights to a file, even if the user has File
Editor ‘Edit’ rights in the User Access screen.

User Access - File Editor Audit tab

An audit trail can be created by Surveyor/400 to log any records which a user adds, changes or
deletes through the File Editor.

Audit Type

You can choose to perform audit logging to either a Spooled File or a Database file.

Field descriptions:

None No audit trail is created.

Spooled File
Auditor

If the ‘Spooled File Auditor’ option is selected, then you can specify
the output queue for storing the auditing spooled files. For each File
Editor session, a separate spooled file will be created. The name of
the spooled file will be SFEAUDIT. Leaving the Output Queue field
blank indicates the user’s default output queue will be used.

Database File
Auditor

If the ‘Database File Auditor’ option is chosen, then you can specify
the name of a database file name to store the audit entries into. This
auditing file will be created by Surveyor/400 the first time it is used.
See appendix A for the field layout for the auditing database file.
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Audit Options

After specifying an Audit Type, you can then click the ‘Audit Options’ tab to choose between
record or field-level auditing:

Field descriptions:

Record Level
Auditing

For each record added, changed or deleted: An audit log entry will be
created with the complete record image. The fields in the record image
will be separated with a pipe | character.

Field Level
Auditing (Show all
Fields)

For each record added, changed or deleted: An audit log entry will be
created for each field (even for the fields that did not change).

Field Level
Auditing (Show
only changed
Fields)

For each record changed: An audit log entry will be created for each field
changed. Additions and deletions will also be logged.

User Access - IFS tab

The Integrated File System (IFS) is the area of the IBM i where stream files can be stored, such
as pictures, text files, PDFs, Excel documents, etc. Using Surveyor/400, users can explore and
manage files and folders located within the IFS. 

The IFS tab on the User Access screen allows you to control the user’s rights to IFS folders and
files within Surveyor/400.
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Field descriptions:

IFS Read
Access

Allows a user to expand and view the contents of IFS (Integrated File System)
folders located in the Visual Tree.

IFS Write
Access

Allows a user to modify (edit, copy, paste, delete, rename) any IFS folders and
files which they have OS/400 permissions to.

IFS Share
Authority

Allows a user to display, create, change or delete IFS file shares.

User Access - SQL tab

The SQL tab on the User Access screen allows you to control the user’s rights to run SQL
statements in Surveyor/400.

Field descriptions:

Allow SQL Indicates if the user can run SQL SELECT statements for
viewing data.

Allow SQL
Updates/Deletes/Inserts

Indicates if the user can run SQL statements that insert, update
or delete database records.
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Allow Database
Maintenance

Indicates if the user can run SQL statements that create, alter or
delete database files and procedures.

Allow Procedure Calls Indicates if the user can call stored procedures.

SQL Log Database File: Specify the name of a database file name/library to store an
SQL audit log. SQL executed through the SQL Editor will be
stored here. Logging Select statements is optional.

User Access - Data Transfer tab

The Data Transfer tab on the User Access screen controls the user’s rights to transfer data and
objects within Surveyor/400.
Field descriptions:

Export files
from IBM i

Indicates if the user has the ability to export (download) database records
from the IBM i to their workstation or IFS.

Export
Layouts

Indicates if a user can export data through an authorized File Layout.

Export to
Database

Indicates if the user can export records into another database file.

Import files to
IBM i

Indicates if the user has the ability to import (upload) PC files into IBM i
database files.

Import – Allow
Replace

If the user can import data, then indicate if the user can replace the existing
records in IBM i database files.

FTP Access Indicates if the user can FTP objects and libraries.
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Max Export
Records

Limit the number of records a user can export.

User Access - Data Transfer Log tab

If a user has authority to transfer data within Surveyor/400, then an audit log can record details
about each transfer that is performed by the user. These audit logs are stored as database
records. Example:

Field descriptions:

Export Log
Database File and
Library

If the user has authority to export data, then you can specify the name
of a database file name/library to store the transfer audit log entries
into.

Import Log
Database File and
Library

If the user has authority to import data, then you can specify the name
of a database file name/library to store the transfer audit log entries
into.

Export Spool Log
Database File and
Library

If the user has authority to export spooled files, then you can specify
the name of a database file name/library to store the transfer audit log
entries into.

The auditing files will be created by Surveyor/400 the first time they are needed for logging.
See appendix A for the field layouts for the auditing files.
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User Access – TN5250 tab

The TN5250 tab on the User Access screen controls the user’s rights to use the Telnet 5250
feature in Surveyor/400.

User Access – Spooled Files tab

The Spooled Files tab on the User Access screen controls the user’s rights to work with
spooled files on the IBM i .

Field descriptions:

Access to all
Spooled Files

If selected, the user will have access to any spooled file in any output
queue which they have OS/400 authority to.

No Spooled File
Access

If selected, the user will not have access to any spooled files on the
system.

Access to only user’s
Spooled Files

If selected, the user will have access only to the spooled files they
created.

Manage Spooled
Files

Indicates if the user can manage spooled files, such as holding,
releasing, deleting, and moving spooled files.

Export Spooled Files Indicates if the user can download spooled files to their workstation.

User Access – Data Areas tab

The Data Areas tab on the User Access screen controls the user’s rights to view/modify the
values of Data Areas using Surveyor/400.
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User Access Recommendations
Listed below are the authorities which a Surveyor/400 administrator may want to set for end-
users (non-IT personnel) who just need to query and download data:

Authority Setting Reason

Object Access Off So the user cannot access objects directly without
using a File Layout

Administrator Rights Off So the user does not have rights to all Surveyor/400
functions and cannot modify User Access authorities.

Command Editor /
Custom Commands

Off So the user cannot enter OS/400 commands in
Surveyor/400.

Modify Library List Off So the user is restricted to the libraries which are
assigned to him/her.

File Editor View So the user can only view/query data in database files
(not change data).

Public Layout Authority Off So the user can only use File Layouts which are
specifically assigned to them.

IFS Write Access Off So the user cannot modify IFS folders and files.

Allow SQL
Updates/Deletes/Inserts

Off So the user cannot run SQL statements that insert,
update or delete database records.

Allow Database
Maintenance

Off So the user cannot run SQL statements that create,
alter or delete database files and procedures.

Export Layouts On So the user can download data through authorized
File Layouts.

Import files to IBM i Off So the user cannot import records into database files.

FTP Access Off So the user cannot FTP objects between IBM i
systems.

Manage Spooled Files Off So the user cannot delete or move spooled files.
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Restricting Access to Libraries, Files, Fields
and Records
Surveyor/400 will honor any existing OS/400 user authorities specified for libraries and objects
on the IBM i . In other words, if a user does not have authority to an object on the IBM i , then
they will not be able to access that object through Surveyor/400.

In addition to normal OS/400 security, Surveyor/400 allows an administrator to further restrict
a user (or group of users) to specific libraries and files on the system. By creating custom File
Layouts in the Surveyor/400 File Editor, you can also hide fields and records within database
files. These custom File Layouts can be granted to authorized users for viewing, printing and
downloading (exporting) database records.

Surveyor/400 Library Security

As a Surveyor/400 administrator, you can restrict a user (or group of users) to certain libraries
(library list) on an IBM i system or LPAR. A user’s library list can be configured in the
Surveyor/400 User Access screen by following the steps below:

1. The User Access screen can be accessed by right-clicking an IBM i system within the

Surveyor/400 Visual Tree, then selecting the ‘User Access’ option.

2. If the user is already defined in Surveyor/400, then select the user and click the ‘Edit’

button. Otherwise, click the ‘Add’ button to add the user to Surveyor/400.

3. On the ‘General’ tab, uncheck the ‘Modify Library List’ field so the user cannot modify

their own library list.

4. Click the button labeled ‘Modify Library List’ to set the library list for the user. Read

page "Library List Types" on page 152 for more information on how to configure a

library list.

5. Specify any additional user security options and click the ‘OK’ button to save the user

settings.
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6. When the user signs on through Surveyor/400, they will only have access to the library

list you specified for him/her.

Surveyor/400 File, Field and Record Security

A user (or group of users) can be restricted to specific database files, fields and records on an
IBM i system or LPAR. In order to do this, a Surveyor/400 administrator needs to configure the
user (using the User Access screen) so they do not have direct access to objects and do not
have rights to public File Layouts. The user will then only be able to open database files by
using custom File Layouts that were authorized to them.

Configuring User Access authority

Follow the steps below to restrict a user’s access to objects and public File Layouts:

1. The User Access screen can be accessed by right-clicking an IBM i system within the

Surveyor/400 Visual Tree, then selecting the ‘User Access’ option.

2. If the user is already defined in Surveyor/400, then select the user and click the ‘Edit’

button. Otherwise, click the ‘Add’ button to add the user to Surveyor/400.

3. On the ‘General’ tab, uncheck the ‘Object Access’ field so the user cannot directly

access objects on the IBM i .

4. If you only want the user to be able to view data (not change it) in database files, then

choose the ‘View’ option on the ‘File Editor’ tab.

5. On the ‘File Editor’ tab, uncheck the ‘Public Layout Authority’ field so the user cannot

access File Layouts which have public authority.

6. Specify any additional user security options and click the ‘OK’ button to save the user

settings.

Creating a Custom File Layout

If a user does not have ‘Object Access’ and ‘Public Layout Authority’ rights in the User Access
screen, then they can only access a database file through an authorized File Layout. Follow the
steps below to create a custom File Layout for a user (or group of users):
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1. Open a database file with the Surveyor/400 File Editor.

2. The File Editor will show all the fields in the file. To hide a field in the file, you can right-

click the field’s column heading and choose the ‘Hide’ menu option.

3. To subset the records shown, you can specify a filter by clicking the toolbar icon and

then enter the conditions. See page "Filtering Records" on page 34 for more information

on how to specify a filter.

4. Make any additional changes needed to the File Layout and then click the toolbar

icon to save the layout.

5. Specify the Layout’s name and description, then click the ‘Set Layout Authority’

checkbox and press enter.

6. From the authority screen, click the ‘Add’ button to give a user (or user group) rights to

the layout. Make sure the following boxes are unchecked for the user:

l Modify Layout Authority

l Delete Layout

l Update Layout

l Modify Field Layout (if you don’t want the user to unhide fields in the layout)

l Modify Filter (if a filter is defined and you don’t want the user to access other

records)

l Open Without Filter (if a filter is defined and you don’t want the user to access

other records)

7. See page "Layout Authority" on page 52 for additional instructions on the Layout

Authority feature.

8. The user can access the File Layouts authorized to them by opening the ‘Layouts’ folder

from the Surveyor/400 Visual Tree.
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Certificate Manager
Use the 'Certificate Manager' to work with all SSL Certificates used in Surveyor/400.

Buttons:

Import Import a certificate from a text file

Note: First you must obtain the certificate. If you are using DCM, use the 'Install
Local CA Certificate on Your PC - Copy and paste certificate' option

View View the details for a Certificate

Rename Change the Certificate's alias

Delete Remove a certificate

Close Closes the Certificate Manager
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Miscellaneous
Surveyor/400 Command
Line Options
Additional command line options can be specified when launching the Surveyor/400
application.

To specify the options, first locate the surveyor application launcher, which is located in the
Surveyor installation directory. Within Windows, the launcher name is “surveyor.exe” and is
located in the directory of “C:\Program Files\HelpSystems Software\Surveyor” by default. Then
choose the appropriate Command Line option.

Option Description

-nowebupdate No Web Update. Runs Surveyor/400 without the Web
Update option. Useful for restricting users from
updating Surveyor/400 via the internet.

-addregfa Windows only. Add registry file associations.
Associates certain file types with Surveyor/400.

-removeregfa Windows only. Removes registry entries that associate
certain file types with Surveyor/400.

Listed below is an example of launching Surveyor/400 while disabling the Web-Update feature
for that workstation:

"C:\Program Files\HelpSystems Software\Surveyor\Surveyor.exe" -nowebupdate
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Port Usage
Surveyor/400 components connect to the IBM i through TCPIP ports. These ports must not be
blocked by a firewall or exit programs.

Component Ports

Main Surveyor/400 application 449, 8470, 8471 and 8476

Spooled File View/Export 8474

File Editor                   446

Custom commands     8475

IFS   8473

Data area access     8475

TN5250  23 ( Configurable )

FTP 21
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Surveyor/400 Updates
Getting Surveyor/400 Updates from
HelpSystems
New versions of Surveyor/400 can be retrieved from HelpSystem's server using the
Surveyor/400 "Web Update" feature. It is recommended that you perform a Web Update after
Surveyor/400 is first installed and then on at least a monthly basis since new features are
being added on a frequent basis. Follow the instructions below to perform a Web Update:

1. Make sure you have an active Internet connection from your workstation.

2. Select the ‘Help’ drop-down menu and choose the ‘Web Update’ option.

3. If there is a newer version on HelpSystem's server, a description of the new version’s

features/fixes will be displayed and you will be prompted to upgrade. If you accept, the

latest version of Surveyor/400 will be retrieved onto your workstation.

4. Once finished, restart Surveyor/400 and the updates will be automatically applied.

NOTE:

If unable to connect to HelpSystem's server using the ‘Web Update’ option and if there is a
Proxy Server on the network, then you need to enter the Proxy port information in the
Network preference of the Configure screen (pocketknife icon).
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Distributing Surveyor/400 Updates
If you are a Surveyor/400 administrator, you can upload the new version from your workstation
to the IBM i ’ IFS (for distributing to other users). To perform this version upload, right-click the
IBM i system icon in the left panel and select ‘Update Server’.

Users can get the latest version from the IFS automatically when they connect with
Surveyor/400. This is dependent on the frequency setting specified within their configuration
settings. Users can also download the IFS version by right-clicking the IBM i system icon and
choosing ‘Check for Updates’.
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Uninstalling Surveyor/400
To uninstall the IBM i server component of Surveyor/400, select the ‘Configure’ screen in
Surveyor/400. Then select the IBM i system and click the ‘Uninstall’ button. All users must first
be signed off Surveyor/400 for this to work properly.

Optionally, you can remove the server component of Surveyor/400 by running the following
command on the IBM i : DLTLICPGM LICPGM(4SURVEY). Also remove IFS folder
/helpsystems/surveyor.

For Windows, the Surveyor/400 client component can be removed by first selecting the ‘Add or
Remove Programs’ icon in the control panel. Select Surveyor/400 from the list and click the
‘Remove’ button.
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Additional Tips
l You can initiate actions against many Surveyor/400 screen components and objects by

right-clicking them. For instance, to work with the records in a file listed in the tree,

right-click the file and choose "Edit".

l If you already know the file or object name to work with, it is recommended you use the

Fast Path prompter (lightning bolt icon) so you don't have to drill through the tree to

find it.

l Columns can be moved left or right by 'dragging' the column with your left mouse

button. You can also hide and resize most columns. Surveyor/400 will remember your

column settings between sessions if that option is enabled in the Configure screen

(pocketknife icon).

l If you are searching for files/objects through the search screen and want to abort the

search, just press the "Escape" key on your keyboard.

l To see detailed file information (i.e. size) in the tree, check the "Detailed File

Information" option in the “Configuration” screen.

l To export or print information shown on the screen, right-click any column heading in

that screen and select Export or Print.

l To modify user authority to Surveyor/400 functions, right-click the IBM i system icon in

the tree and select ‘User Access’. Administrator rights are required to perform this

option.

l You can download DB2 data from the IBM i to the PC or IFS using various functions

within Surveyor/400. Records can be downloaded from within the File Editor (export

icon or right-click any column heading or RRN), the Fast Path (by selecting the Export

button), the SQL results screen (by selecting File-> Export) and also by opening the

Layouts folder in the tree (right-clicking the layout and then selecting “Export”).

Additionally, whenever a file name is listed in Surveyor/400, you can right-click that file

and select “Export”.
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l The File Search screen (binoculars button) is a great way to locate files which are not

used any longer. For example, you can enter criteria to list all files which have not been

used in the last 365 days and are at least 10 MB in size. When you see a file to remove,

right-click that file and choose ‘Delete’.
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Appendix A
Field layout for File Editor audit log
Field Name Type Length Description

AUDIT_
DATE

Date Date of Transaction

AUDIT_TIME Time Time of Transaction

USERID Character 10 User whom performed Transaction

AUDTYPE Character 1 Type of auditing:
A = All fields
C = Changed fields
R = Record level

FILE Character 128 File name in which the transaction was
performed

LIBRARY Character 10 Library where file is located

MEMBER Character 10 Member in file

FORMAT Character 10 Format in file

ACTION Character 10 Type of transaction:

UPDBA BEF = Update before
UPDBA AFT = Update after
ADD RECORD = Add a record
UPDATE = Update
CLRPFM = Clear File
DELETE = Delete
MASS UPDAT = Mass Update
MASS DELET = Mass Delete

RECNO Binary 9,0 Relative Record Number
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VALUE Variable
Length

5000 Value of field or record for transaction.

COMMENT Variable
Length

52 Comment

Field layout for Database Export audit log
Field Name Type Length Description

LOG_DATE Date Date of Transfer

LOG_TIME Time Time of Transfer

USERID Character 10 User whom performed the Transfer

FUNCTION Character 20 Type of Transfer

FILE Character 128 Database file exported

LIBRARY Character 10 Library where database file is located

MEMBER Character 10 Member in database file

QUERY Variable
Length

500 Query used to filter records

DESTI00001 Variable
Length

256 Location/name of destination

TYPE Character 15 Surveyor/400 function used to transfer
records

AOR Binary 1 (A)dded or (R)eplaced records in destination
file

COMPLETION Variable
Length

100 Completion message
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Field layout for Database Import audit log
Field Name Type Length Description

LOG_DATE Date Date of Transfer

LOG_TIME Time Time of Transfer

USERID Character 10 User whom performed Transfer

FUNCTION Character 20 Type of Transfer

FILE Character 128 Database file imported into

LIBRARY Character 10 Library where database file is located

MEMBER Character 10 Member in database file

SOURCE Character 256 Location/name of file imported

TYPE Character 15 Surveyor/400 function used to transfer
records

AOR Binary 1 (A)dded or (R)eplaced records in database

COMPLETION Variable
Length

100 Completion message

Field layout for Export Spooled File audit
log
Field Name Type Length Description

LOG_DATE Date Date of Transfer

LOG_TIME Time Time of Transfer

USERID Character 10 User whom performed Transfer

FUNCTION Character 20 Type of Transfer
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Appendix A / Field layout for Export Spooled File audit log

JOB Character 28 Job

SPLFNUM Binary 9,0 Spooled file number

SPLFNAME Character 10 Spooled file name

DESTI00001 Variable
Length

256 Location/name of destination

TYPE Character 15 Surveyor/400 function used to transfer

AOR Binary 1 (A)dded or (R)eplaced records in destination
file

COMPLETION Variable
Length

100 Completion message
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